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Very little footage is ever seen exactly as shot. Virtually every image 
we see—whether on video, film, or on-line—has gone through 
some color correction. While the name may imply that it’s used for 
“correcting” errors—which it sometimes is!—color correction has 
moved well beyond that to encompass the use of color to set mood, 
give creative “looks,” match images shot with different cameras/films, 
and simply to be different.

Color correction is an integral part of reproducing motion picture 
images, whether printing to another piece of film or scanning to 
video. Dedicated, expensive, color correction hardware is available to 
do the job, and when combined with the expertise of the “colorist” 
controlling it, marvelous results can be obtained.

The challenge has been to bring this level of control and subtlety to 
the desktop environment which is easily usable by those who are not 
professional colorists.

Color Finesse incorporates many of the same capabilities of those 
dedicated hardware solutions into a desktop product. Combined with 
the 16-bit and 32-bit color support found in Adobe After Effects and 
other applications, Color Finesse provides a level of color control and 
subtlety that is simply not available using those applications’ built-in 
color correction controls.

Color Finesse 3.0 builds on previous versions adding several 
important new features:

•	 New hue, saturation, and lightness curves allow you to freely 
modify colors based on their hue.

•	 Auto Color and Auto Exposure buttons set the input Levels 
control to accomplish basic color temperature and color cast 
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removal, and automatically set black and white points. These 
buttons are also available in the plug-in’s Simplified UI.

•	 A Vibrance adjustment has been added to the HSL Controls 
tab, allowing you to adjust color saturation without ending 
up with the “cartoon” look that can result when using higher 
settings of the Saturation control.

•	 A new Highlight Recovery control has been added to the 
Levels tab. This brings extreme highlights (luma values > 1.0) 
into the range where they can be seen and adjusted. Very 
useful for recovering highlights in film scans.

•	 Proper handling of pixel aspect ratio (PAR) within the Color 
Finesse UI. Anamorphic footage will now be displayed 
properly, according to the settings in the host application.

•	 Color Finesse can now save its settings in a variety of 3-D LUT 
formats. Supported formats include Academy LUT, Autodesk 
(in Lustre, Flame, Smoke, and generic flavors), Blackmagic 
HDLink Pro, Pogle, Scratch, Truelight Cube, Panavision GDP, 
Thomson LUTher, and Cinetal.

•	 The Vectorscope display can now be zoomed using either 
the scrollwheel or the contextual popup menu. This feature 
is available in both the Combo display and the Vectorscope 
display.

•	 Contextual menus in the Combo display allow you to choose 
what appears within each quadrant without having to use the 
Color Finesse Preferences panel.

•	 Additional color correction presets have been added.

Care has been taken to make sure that projects built using Color 
Finesse 2.1 can be easily upgraded to use Color Finesse 3 and 
provide consistent color correction results. There are however, some 
differences between Color Finesse 3 and previous versions you should 
be aware of as it may affect the appearance of your project:

•	 The Levels Output settings behave differently than in previous 
versions. If your project did not alter these settings then you 
do not need to do anything special. If you did use the Levels 

Compatibility With 
Previous Versions
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Output controls, please review these settings after converting 
your project to Color Finesse 3.

This manual covers all aspects of using Color Finesse. It does assume 
that you are familiar with the general operation of your computer, as 
well as whatever application you’re using Color Finesse within, such 
as Adobe After Effects, Apple Final Cut Pro, or Adobe Premiere Pro.

In order to install and use Color Finesse on a Macintosh, you will 
need a minimum of:

•	 Intel-based, or PowerPC G4 or G5 Macintosh computer.

•	 At least 1GB of memory; 2GB is recommended.

•	 Mac OS X 10.5 or later, including 10.6 (Snow Leopard).

•	 A monitor running at 1024x768 or greater resolution.

•	 QuickTime 6.0 or later.

•	 Adobe After Effects CS3 or later and/or Apple Final Cut Pro 
5.0 or later. For version requirements for other host software, 
please refer to our web site for the latest information.

To install and use Color Finesse on a Windows system, you will need 
a minimum of:

•	 Intel Pentium III or later processor with SSE instruction set 
(Pentium 4 or Xeon strongly recommended), or AMD Athlon 
XP or later with SSE instruction set enabled in the BIOS.

•	  At least 1GB of memory; 2GB is recommended.

•	 Windows XP SP2 or later, Windows Vista (including Vista 64), 
or Windows 7 (including 64-bit flavors).

•	 A 1024x768 (or larger) display.

•	 QuickTime 7.0 or later.

•	 Adobe After Effects CS3 or later or Adobe Premiere Pro CS3 or 
later.

Color Finesse is distributed as an installation program which 
will install all components of Color Finesse, including plug-ins, 
applications, documentation, and other related files onto your 
system. It is important that you use this installer program to 
install Color Finesse, rather than manually dragging files, to ensure 

About This Manual

Minimum System 
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that everything is installed in the proper location and that the 
components are properly linked together.

If you are using the version of Color Finesse LE bundled with Adobe 
After Effects, the software has been automatically installed for you 
by the Adobe installer. You will find Color Finesse in the After Effects 
Effects menu under the Synthetic Aperture category. The first time 
you apply it to a layer you will be prompted for your Color Finesse 
serial number. Other than entering that serial number there are no 
other steps needed.

For others, prior to installing Color Finesse you must quit from any 
host application you will be installing Color Finesse into, such as 
Adobe After Effects or Apple Final Cut Pro. We strongly recommend 
that you turn off virus protection programs prior to installing Color 
Finesse, as they can prevent the installer from creating a working 
installation.

Color Finesse uses different installation programs depending on the 
host application you will be using with Color Finesse. You must use 
the proper installer for your application.

There are separate installers for After Effects 6.x, After Effects 7.0, Final 
Cut Pro, and one for all other host applications such as Autodesk 
Combustion or Boris Red.

If you wish to install Color Finesse into multiple host applications, 
you will need to use the proper installer for each host and install 
Color Finesse multiple times, once for each host application.

Once you have chosen the correct installer, double-click the installer 
icon with the .mpkg extension. When you see the welcome screen, 
click Continue to proceed with the installation.

Review the “read me” information for important updates which may 
have occurred since this document was written. The read me always 
has the latest information. Then click Continue.

Review the software license agreement. By clicking Agree and 
continuing with the installation process, you signify that you agree 
to the terms of the License Agreement. If you do not agree with the 
License, do not install the software, and return the product for a 
refund.

Installing Color Finesse 
on Macintosh
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You’ll then be prompted for the location in which to install the Color 
Finesse plug-in. Click Choose and navigate to the correct folder for 
the host application you are installing Color Finesse into. For After 
Effects, this will be the Plug-ins folder. For other host applications you 
will need to determine the correct location for that host. For Final Cut 
Pro, there is only one valid location, so you will not be asked for the 
location and no Choose button will be shown.

Once you’ve chosen the installation location, click Continue.

You’ll then see a confirmation screen. Depending on whether you’ve 
installed Color Finesse previously on this system, you’ll see a button 
labeled Install or Upgrade. Click that button.

You’ll now be asked to enter your name, organizational affiliation (if 
any), and your serial number. If you wish to evaluate the software 
prior to purchasing it, you can install it without providing a serial 
number by clicking Trial Mode. When used in trial mode, the 
software will work without limitation other than placing red lines 
across the rendered image. You will need to purchase a serial number 
and reinstall Color Finesse to remove the red lines.

If you wish to fully enable the software, enter the serial number you 
received when you purchased the software and click Register. The 
installer will now complete the installation process.

You’ll then have the option of going to the Product Registration 
page on the Synthetic Aperture web site. This convenient on-line 
registration process ensures that you will be kept up-to-date on 
product revisions and updates, and that a record is kept of your Color 
Finesse serial number. Should you ever misplace your serial number, 
we won’t be able to help you unless you complete the registration.

Color Finesse uses different installation programs depending on the 
host application you will be using with Color Finesse. You must use 
the proper installer for your application.

 If you are installing Color Finesse for use with Adobe After Effects 
or Adobe Premiere Pro 1.5 or later, you will use one installer; if you 
are installing Color Finesse for use with other applications, such as 
Discreet Combustion, Avid, or Boris Red, you will use a different 
installer program.

Installing Color Finesse 
on Windows
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If you wish to install Color Finesse into multiple host applications, 
you will need to use the proper installer and run it multiple times, 
once for each host application. 

Once you have chosen the correct installer, double-click the installer 
icon. When you see the welcome screen, click Continue to proceed 
with the installation.

Review the software license agreement. By clicking Yes and continuing 
with the installation process, you signify that you agree to the terms 
of the License Agreement. If you do not agree with the License, click 
No, do not install the software, and return the product for a refund.

You will now be asked to enter your name, organizational affiliation 
(if any), and your serial number. If you wish to evaluate the software 
prior to purchasing it, you can install it without providing a serial 
number by clicking Next without entering a serial number. When 
used in trial mode, the software will work without limitation other 
than placing red lines across the rendered image. You will need to 
purchase a serial number and reinstall Color Finesse to remove the red 
lines.

If you wish to fully enable the software, enter the serial number you 
received when you purchased the software and click Next.

The installer will next ask you to specify where you would like the 
documentation, support files, uninstaller, and other miscellaneous 
items to be installed. You can accept the default location, or specify 
a directory of your choosing. Click Next to proceed with the 
installation.

The installer will ask you to confirm that you wish to proceed with 
the installation. If you want to change any of your previous choices, 
click Back and make any changes. To proceed, click Next.

The Color Finesse plug-in needs to be installed into the correct plug-
in folder for the host application you are installing Color Finesse into. 
The installer will ask you to locate and select that folder. Once you 
have selected the proper folder, click Choose.

The installer will now complete the installation process. When the 
installation is complete, click Next to exit the installation application 
and go to the Product Registration page on the Synthetic Aperture 
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web site. This convenient on-line registration process ensures that 
you will be kept up-to-date on product revisions and updates, and 
that a record is kept of your Color Finesse serial number. Should you 
ever misplace your serial number, we won’t be able to help you unless 
you complete the registration.

From the Windows Start menu, you can access this document in 
Adobe Acrobat (PDF) format, a copy of the Color Finesse software 
license, a software registration form, a read-me file with any last 
minute updates, and an uninstaller.

Registering your copy of Color Finesse with us is important. It allows 
us to let you know about product updates and corrections. If you 
should ever misplace your registration code or serial number, it is the 
only way we’ll be able to help you retrieve it. And it speeds technical 
support because we already have information about you and your 
products.

You can register your software on-line as the final step in installing 
the software by directing your web browser to www.synthetic-ap.com/
register or by printing out the Register Color Finesse.pdf file that is 
installed with the software and mailing or faxing it to us.

Your privacy is important to us; Synthetic Aperture never shares your 
registration information with third parties, and won’t send you email 
unless you indicate on your registration form that it is OK to do so.

Technical support is available via electronic mail. When reporting 
a problem, please specify the version of the operating system, 
QuickTime, Color Finesse, and application program (After Effects, 
Final Cut Pro, etc.) you are using. Be sure to let us know whether you 
are using a Macintosh or Windows system.

If you received Color Finesse as part of an Adobe product, please 
contact Adobe Technical Support for assistance. Contacting Synthetic 
Aperture directly will only result in unnecessary delays.

We periodically post fixes and updates on our Web site. Before 
investing the time to report a problem, check there to see if the 
problem is already resolved via a software update.

Electronic Mail mailto:support@synthetic-ap.com

Web Site http://www.synthetic-ap.com/

Registering Your 
Software

Technical Support
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We also maintain a Knowledge Base of frequently asked questions and 
their answers, as well as other technical documents, in the Support 
section of our web site.

You can access the Color Finesse on-line Knowledge Base, and check 
to see if updates to your version of Color Finesse are available via the 
Help menu within the full Color Finesse UI.

We encourage you to contact us with any suggestions, comments, or 
questions. We are constantly working to improve our products, and 
most of those improvements are based directly on your feedback.

Please Tell Us What 
You Think
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Color correction is simply the work of altering image colors and 
tonalities to better match what was imagined when the image was 
first created. It can be as simple or as complex as needed to get the job 
done.

The term “correction” is something of a misnomer because you aren’t 
always correcting or fixing something, but may simply be enhancing 
the image through color manipulation.

Most of the time you’re not aware that color correction has been 
performed. When you watch a film in a theater, you take for granted 
that there is continuity in color from scene to scene, and that a sunny 
beach scene has bright saturated colors. The film may very well not 
have started out that way, prior to color correction.

In other cases, such as with the current spate of television 
commercials, it’s very obvious that color correction has been 
performed, giving the images an other-worldly, distorted color palette.

Subtle or obvious, this is all part of color correction.

There are many times when you’ll find you need color correction, 
including improper white balance, mixed lighting, color casts 
from adjacent walls, correcting for the effects of aging film stocks, 
matching footage shot on different film stocks, at different times of 
day, or simply from different angles, and matching product shots and 
logos against approved color swatches.

And beyond all the “correction” tasks, even footage that appears 
perfect can benefit from color correction to add visual appeal, a 
specific “look,” or to express your creative vision.

Traditionally, color correction has been available in two forms: 
high-end correction systems running on dedicated hardware with 
proprietary software, or simple correction tools built into desktop 
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compositing or editing programs. Color Finesse aims for the middle 
of those two extremes, bringing the capabilities of those high-end 
systems to inexpensive desktop software.

Much color correction can be accomplished using the built-in 
capabilities of, say, After Effects or Final Cut Pro. However, complex 
correction tasks often involve the need to “stack” several correction 
filters, one after the other. Even when working in a 16-bit color 
environment, each filter needs to round its output before passing it 
on to the next filter. The error in that rounding accumulates, and 
accounts for the “harsh” or “crunchy” look of much color correction 
done that way. And, of course, some applications are still limited to 
8-bit color manipulation, where accumulating error quickly limits 
the amount of correction that can be done. Color Finesse eliminates 
the entire issue by performing all of its color correction—which 
encompasses capabilities otherwise requiring multiple plug-ins—in 
one step, reducing the rounding to just one occurance.

Color Finesse also offers secondary color correction, a capability sorely 
missing from many editing and compositing programs.

Over the years, a great deal of jargon has grown up around color 
correction. One of the often heard bits is “primary” and “secondary” 
color correction. These terms are used to differentiate between 
correction of the overall image (primary correction) and correction 
of specific elements or areas within the image (secondary correction). 
They got their names because you typically would do anything 
considered primary correction first, followed by secondary correction 
tasks.

For example, consider an image with a woman wearing a yellow 
scarf. For some reason, the whole image has a greenish-cast; none too 
flattering to her complexion.

You would start by removing the overall green cast until things looked 
right. You might also adjust the black and white points to give the 
image more “snap.” These would be primary corrections.

But now that you’ve removed the green cast, you might decide that 
the yellow scarf has shifted too far towards orange (because of the 
green you removed) and that it doesn’t look right. At this point, you 
could select and adjust the color only of the scarf, leaving the rest of 
the image alone. That would be a secondary correction.

Primary vs. Secondary 
Correction
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Color Finesse Fundamentals 3

Color correction is a specialized operation and Color Finesse 3 
provides a specialized user interface for performing it, as well as 
providing a subset of its controls directly within the host application.

In addition to providing a more logical arrangement of controls than 
a long list of sliders, Color Finesse’s specialized user interface also 
provides a variety of displays to help measure your correction efforts 
objectively. Of course, what really matters is the visual result, and 
Color Finesse incorporates numerous ways to adjust the correction 
controls.

To begin a color correction operation, apply Color Finesse to a clip 
the way you would any other video effect. The details of applying 
Color Finesse in commonly used applications are covered below.

In Adobe After Effects you’ll find Color Finesse in the Effect menu 
under Synthetic Aperture>SA Color Finesse 3.

To apply Color Finesse, select the layer you wish to apply Color 
Finesse to in the timeline. From the Effects menu, select Synthetic 
Aperture>SA Color Finesse 3.

An entry for Color Finesse should now appear in the Effect Controls 
window. You should see the Color Finesse logo above a rainbow line, 
and four buttons below that. If you do not see all four buttons, you 
may need to widen the Effect Controls window or scroll horizontally.

You are now set to use either the plug-in’s simplified interface or to 
invoke the full Color Finesse interface, both of which are covered in 
detail later in this chapter and the next.

In Apple Final Cut Pro, Color Finesse will be in the Video Filters 
section of the Effects menu under Synthetic Aperture>SA Color 
Finesse 3.

Applying Color 
Finesse to Your Clip

Adobe After Effects

Apple Final Cut Pro



To apply Color Finesse to a clip, first load the clip into the Viewer 
either by double-clicking the clip in the Timeline, or by selecting the 
clip and choosing View>Clip from the menu bar.

Once the clip is in the Viewer, apply Color Finesse by choosing Video 
Filters>Synthetic Aperture>SA Color Finesse 3 from the Effects menu. 
To see the Color Finesse controls, click the Filters tab in the Viewer.

You should see the Color Finesse logo above a rainbow line, and four 
buttons below that. If you do not see all four buttons, you may need 
to widen the Parameters column. Below the buttons you will see the 
Color Finesse simplified interface.

You are now set to use either the plug-in’s simplified interface, or to 
invoke the full Color Finesse interface, both of which are covered in 
detail later in this chapter and the next.

In Adobe Premiere Pro Color Finesse will be located in the Effects 
Palette under Synthetic Aperture>SA Color Finesse 3.

To apply Color Finesse, click on the Effects palette in Premiere Pro 
and locate the Video Effects folder. Open that and locate the Synthetic 
Aperture folder. Open that folder and you’ll see the SA Color Finesse 3 
effect.

Click on the SA Color Finesse 3 effect and drag it onto the desired clip 
in the timeline. The effect is now applied.

Locate the Effect Controls tab and you will see SA Color Finesse 3 
listed under the applied Video Effects. Twirl open SA Color Finesse 3. 
In the revealed parameters, twirl open Parameters.

You should see the Color Finesse logo above a rainbow line, and four 
buttons below that. If you do not see all four buttons, you may need 
to widen the column so that all buttons are visible.

You are now set to use either the plug-in’s simplified interface or to 
invoke the full Color Finesse interface, both of which are covered in 
detail later in this chapter and the next.

Other applications will have Color Finesse similarly located in the 
application’s video filters or effects. Apply Color Finesse as you would 
any other video filter plug-in. Be sure to check the Support section of 
our web site for specific instructions on using other host applications.

Adobe Premiere Pro

Other Host Applications
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The Color Finesse plug-in interface consists of four buttons with 
which to control the basic operation of Color Finesse. The four 
buttons are Full Interface, Load Preset, Reset, and About. Below those 
buttons are the sliders and other controls which make up the 
simplified interface, described below.

The Full Interface button invokes the full Color Finesse user interface, 
described in detail below.

The Load Preset button allows you to load previously saved settings, 
whether settings you’ve saved as a preset or one of the many presets 
supplied with Color Finesse.

The Reset button resets all Color Finesse controls back to their neutral 
setting, eliminating all color correction. You should always use this 
reset button to reset Color Finesse controls, rather than any reset 
button provided by the host application.

The About button displays information about Color Finesse, 
including the version (in the lower right corner) and your software 
serial number and registration information (in the upper right 
corner).

Below the four buttons described above is the simplified interface. 
This interface provides a subset of the controls available in the 
full Color Finesse interface and can be used both to establish an 
initial color correction, or to fine tune a correction you’ve already 
established.

Basic Plug-In 
Operation

The Color Finesse 
Simplified Interface
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While only a subset of the controls available in the full interface, 
the simplified interface provides access to the most commonly used 
controls without needing to move from the host application to the 
Color Finesse full interface.

The simplified and full interfaces are fully interoperable: you can 
make adjustments in either interface and the other interface will be 
updated. Which interface you use is entirely a personal choice.

To use the simplified interface it may be necessary to twirl open the 
controls so that you can see them. Some host applications (After 
Effects, Premiere Pro) provide this capability to make it easy to get to 
just the control you want to use. Other host applications (Final Cut 
Pro) present all controls at once, which makes them easier to get to, 

	 14	 Color Finesse Fundamentals



	 Color Finesse Fundamentals	 15

but may require more vertical scrolling to move from one control to 
another.

The simplified interface gives you access to the HSL and RGB controls, 
Hue Offset wheels, RGB Curves, and the broadcast Limiter. Within the 
HSL and RGB controls, you have access to Master, Highlight, Midtone, 
and Shadow controls. Details of using these controls are covered in 
later chapters.

To adjust your color correction settings using the full interface, click 
the Full Interface button. The Color Finesse user interface will now 
appear. If this is the first time you’ve clicked the Full Interface button 
in this session, you may see the Color Finesse splash screen, and there 
may be a slight pause while the user interface is initialized.

The Color Finesse interface is divided into four main windows: the 
Analysis Window, the Image Window, the Settings Window, and 
the Color Info Window. Each window has a set of tabs which can be 
clicked to select panes within that window, with the exception of 
the Color Info Window, which has no tabs. As you work, you’ll find 
yourself switching between different panes, depending on the color 
correction operation you’re performing. Dividing the screen into 
different windows ensures that you’ll be able to see the information 
you need as you make color correction adjustments.

The Color Finesse Full 
Interface

Analysis 
Window

Settings 
Window

Image 
Window

Color Info 
Window
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The Analysis Window contains a number of displays that are intended 
to allow you to view the image you are correcting in an objective 
fashion. Included are traditional displays you would find in the 
typical telecine bay, including several different styles of waveform 
monitors and a vectorscope, as well as more specialized displays such 
as histogram displays and a level curve display. Because it is often 
useful to see several of these displays simultaneously, Color Finesse 
also includes a Combo pane which incorporates four displays of your 
choice on one pane. Additional information on these displays can 
be found in “Analysis Window Displays” later in the next chapter. 
Information on choosing which four displays will be shown in the 
Combo pane can also be found there and in Chapter 5, “Preferences.”

In addition to those displays, the Analysis Window is also home to 
the Reference Gallery pane. Additional information on the Reference 
Gallery can be found in “The Reference Gallery” section of the next 
chapter.

By default, the Combo pane will be displayed in the Analysis 
Window when you first start the Color Finesse interface. This default 
can be changed in Color Finesse’s Preferences (see the Chapter 5, 
“Preferences”).

The Image Window provides several different ways for you to look 
at the image you are correcting. You can look at the Result pane, 
which shows the result of all of the color correction settings currently 
enabled. You can look at the Source pane, which shows the source 
image prior to any corrections. The Split Source pane shows a split 
screen image combining both the source and result images, giving a 
“before and after” look at the corrections being performed.

The Reference pane shows the currently selected reference image. (See  
“Choosing a Reference Image” in the next chapter for information on 
choosing a reference image.) The Split Ref pane shows a split screen 
combination of the reference image and the result image; ideal for 
comparing two scenes for a correct color match.

The Luma Ranges pane shows the source image as it is broken down 
into shadow, midtone, and highlight regions, as defined in the Luma 
Ranges pane of the Settings Window.

Analysis Window

Image Window
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By default, the Result pane will be displayed in the Image Window 
when you first start the Color Finesse full interface. This default 
can be changed in Color Finesse’s Preferences (see Chapter 5, 
“Preferences”).

The Settings Window contains the controls you’ll use for performing 
the actual color corrections. Individual panes give access to HSL 
correction, RGB, CMY, and YCbCr channel correction, curves, levels, 
luma ranges, secondary color correction, and chroma and luma 
limiting.

By default, the HSL pane will be displayed in the Settings Window 
when you first start the Color Finesse full interface. This default can 
be changed in Color Finesse’s Preferences.

The Color Info Window is used to sample and display colors from the 
image you’re correcting. Color swatches in the Color Info Window 
show you the sampled color both before and after color correction 
has been applied. A popup menu also allows you to choose the format 
for displaying numeric color values. (For Windows users, this type of 
menu is also known as a “drop-down list.”)

Also contained in the Color Info Window is the color matching 
control. This allows you to choose a target color and have Color 
Finesse automatically adjust the active correction controls so that the 
input color is matched to the target color. For more information on 
color matching, see “Color Matching” later in this chapter.

During a typical color correction session, you’ll find yourself using 
many of the tools and controls provided by Color Finesse. Becoming 
proficient with navigating the Color Finesse interface will speed your 
correction work.

You select individual panes by clicking on the tab located on the left 
side of the window. Panes may contain nested panes, whose tabs may 
be clicked in turn. All settings are maintained as you click away from 
a pane, so you may freely click to one pane to check a setting and 
then click back without altering any settings.

Within the Settings Window, each pane’s tab contains a check 
box which activates the controls on that pane. This check box is 
automatically selected whenever you adjust controls within the 

Settings Window

Color Info Window

Navigating the 
Windows

Selecting Window Panes

Activating Panes
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pane. Clearing the check box will deactivate the pane and prevent 
its controls from having any effect on the image. This provides a 
convenient way to disable a set of controls to perform a quick “before 
and after” check, or to explore alternative ways of achieving the color 
correction you are striving for.

The image preview panes—the Result, Source, Reference, and Luma 
Ranges panes—can be zoomed and panned so that you can examine 
the image in detail, regardless of your computer monitor resolution. 
Use the tools in the image preview pane to zoom and pan:

To zoom an image, select the magnifier tool by clicking on the 
magnifier button in the lower right corner of the image preview pane. 
Once the tool is selected, click anywhere on the image to zoom in. 
To zoom out, hold down on the option key (Mac) or control key 
(Windows) while clicking in the image. Double-clicking the magnifier 
button will reset the image to its unzoomed state, where the entire 
image will be visible.

When the image is zoomed, not all of it will be visible in the preview 
pane. To see other parts of the image, you can pan the image within 
the pane using the pan tool. Select the pan tool by clicking on the 
pan tool button in the lower right corner of the image preview pane. 
Click and hold on the image, and move the cursor; the image will 
move with it. When you have the image positioned where you want 
it, release the mouse button.

If your mouse has a scroll wheel, you can use it for zooming the 
preview pane. Position the cursor over the preview pane and move 
the scroll wheel to zoom in and out. If the scroll wheel also includes 
a button, then pressing that button and panning within the image 
preview pane will pan the preview image.

Two of the panes in the Image Window—the Split Source and Split 
Ref panes—allow you to show two different images in split screen 
(sometimes called “split wipe”) format. The Split Source pane provides 

Zooming and Panning 
Preview Panes

Split Screen Panes

Pointer Pan 
Tool

Zoom 
Tool
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a way to compare the source (incoming) image with the result 
(outgoing) image. The Split Ref pane compares the currently selected 
reference image with the result image.

Both panes provide a split screen format which allows you to select 
the location of the screen split. When either pane is selected, the 
display will have two small white triangular markers located at the 
outer edge of the display. By default, these will be located at the 
top and bottom of the display, at the center point of the image. 
You select the location of the screen split by moving these markers. 
One marker moves along the top and left side of the display, while 
the other moves along the right side and bottom of the display. By 
moving these markers to different positions, you can locate the screen 
split wherever it is most useful in comparing the two images. Make 
sure you have the arrow tool selected when attempting to move the 
split markers. You can select the arrow tool by clicking on the arrow 
button in the lower right corner of the image pane.

 If the split is hard to see—because the difference in the images is 
small—you can quickly locate the split by momentarily clicking on 
one of the markers without moving it. A line will be drawn across the 
display for the time you hold down the mouse button.

In addition to the normal view mode of having both an Analysis 
Window and Preview Window visible, Color Finesse also offers a view 

Alternate View Modes
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mode where a single Preview Window replaces both. This mode gives 
a larger preview which allows you to see more detail during 
correction.

To select this mode, choose Single from the View menu in the menu 
bar, or press command+1 (Mac) or control+1 (Windows). To see the 
Analysis/Preview Window combination again, choose Normal from 
the View menu, or press command+2 (Mac) or control+2 (Windows).

When you are viewing moving footage (as opposed to still images) in 
the Result, Source, Reference, and Luma Ranges panes you move 
through the frames of the clip as well as control playback.

The Preview Panes have VTR-style controls located in the lower left 
portion of the window. 

Use these controls to step through the clip and to play the footage.

You can easily scrub through the clip by using the pointer tool (see 
“Zooming and Panning Preview Panes” earlier in this chapter for the 
location of this tool). Click-and-drag on the image pane to scrub back 
and forth through the frames.

You can play the clip (with or without correction, depending on 
which Preview Pane you are viewing) by clicking the Play button in 
the VTR controls. But, depending on your system speed, the 
dimensions of the image, and the speed of your video card, playback 
may not be realtime.

For realtime playback, use the Rapid Preview button instead of the 
Play button. Rapid Preview prepares the corrected preview before 
displaying it, allowing realtime playback on systems which can’t 
otherwise support it.

The Rapid Preview button is the rightmost button in the VTR 
controls. Position the clip at the frame where you wish the preview 
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to begin. Click Rapid Preview once and Color Finesse will begin 
preparing the frames. You can either wait for it to reach the end of the 
clip, or click the Play button to begin playback.

Playback will loop back to the beginning when it reaches the end 
of the Preview. The VTR controls are active so you can pause, stop 
and restart playback as you wish. When you are done with viewing 
the Preview, click Rapid Preview again to return to normal playback 
mode.

If you have an External Preview Monitor or Secondary Preview 
Monitor active, Rapid Previews will be displayed on that monitor, not 
the main monitor.

To ensure proper performance, make sure that the Rapid Preview 
Cache setting in the Color Finesse preferences is set to an adequately 
fast disk.

Color correction often involves a great deal of experimentation, with 
many different combinations of control settings tried before a final 
configuration is chosen. To make that easier, Color Finesse offers a 
number of ways to reset controls to standard settings. 

All control changes can be undone using the undo key (command + Z 
for Macintosh; control + Z for Windows) and redone using the redo 
key (shift + command + Z for Macintosh; shift + control + Z for 
Windows). Color Finesse has multiple levels of undo/redo, the 
number of which can be specified in the Color Finesse preferences. By 
default, there are 20 levels of undo/redo. 

To reset all controls to their default setting, click the Reset All button, 
located at the bottom of the Color Finesse full interface.

Each settings pane has a Reset button which will reset just that pane’s 
controls to their default settings. The controls on all other panes are 
left unaffected.

You can reset just a single slider control to its default value by holding 
down the option key (Mac) or control key (Windows) while clicking 
on the text display of the control’s value.

If your mouse has a scroll wheel, you can use the wheel for making 
small adjustments to the slider controls with more precision than 
simply dragging the slider handle.

Resetting Controls

Undo/Redo

Resetting All Controls

Resetting a Pane’s 
Controls

Resetting a Single 
Control

Using the Scroll Wheel
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Position the cursor over the textual display of the slider value. As you 
move the scroll wheel, the value of the slider will change in small 
increments.

You can save and restore all of the Color Finesse settings using the 
Save and Load buttons. This is particularly handy after you’ve 
developed settings for a particular “look” or for correcting a particular 
color problem. You can also save and load color settings from the 
Settings menu.

 The QuickGrade feature of Color Finesse provides a convenient way 
to store multiple color correction settings which can be recalled with 
a single keystroke. This is ideal for quickly toggling between settings 
when comparing alternative correction choices, or for storing 
commonly used settings for quick recall.

QuickGrades are stored and recalled using the function keys F1-F8. 
The Colorociter Colorist’s Workstation can also be configured so that 
buttons are dedicated to the QuickGrade function.

To store the current color corrections as a QuickGrade, choose one of 
the function keys F1-F8. While holding down the shift key, press the 
function key. The current settings will be stored in that key.

To recall the stored QuickGrade, press the function key you 
originally stored the settings in. The settings will be recalled and all 
controls updated. If you press a function key which does not have a 
QuickGrade stored in it, you will hear the system alert sound.

QuickGrades are saved between projects

You can also save and load settings as ASC CDL format files. This is an 
XML-based file format developed and promoted by the American 
Society of Cinematographers Technical Committee as a “Color 
Decision List” for interchanging color correction data between 
different color correction systems. It stores only a small subset of 
Color Finesse’s settings—basically just the RGB Master gamma, gain, 
and pedestal controls—but the format is well specified so that results 
in one color corrector can be duplicated in another corrector which 
supports the ASC CDL format.

Color Finesse normally updates all images as you manipulate controls, 
providing you with immediate feedback of your adjustments. You can 
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temporarily disable this updating by holding down the option key as 
you move the control. You can also turn off the updates by engaging 
the caps-lock key. To resume updates, release the caps-lock key.

In addition to using the sliders and other controls to manipulate the 
correction settings, you can also enter numeric values. This is 
sometimes advantageous when you want to change a value with 
greater precision than is afforded by a slider, or when you want to 
enter a value that is outside the range of the slider.

To enter a numeric value, click on the underlined numeric value 
displayed to the right of the control. The value will change to editable 
text. Enter the value you want to assign to the control and press 
return to close the editing, or press tab to close the editing and move 
to the next field.

The Color Info Window is divided into two halves: the upper half is 
used for sampling colors from images and displaying the effect your 
correction settings will have on the sampled color. The lower half is 
used for color matching, which is discussed in detail in “Color 
Matching,” below.

The color sampler is always available, but the color matcher is only 
available when the Settings Window has a pane selected which 
provides color matching; otherwise the color matching controls are 
disabled and dimmed.

Entering Numeric Values

Color Info Window 
Tools
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The color sampler lets you sample colors from your images so you can 
better analyze the effects of the color correction. The Color Info 
Window displays the color you have sampled in the sample color 
swatch, both as a colored background and as the color’s numeric 
value. Just to the right of it is the result color swatch which displays 
the sampled color after the current color correction settings have been 
applied.

You can use this to help you determine the type of correction needed, 
and to judge how successful your corrections are. For example, if 
you have an area of shadowed snow that doesn’t look “right,” use 
the color sampler to sample an area of the snow. By looking at the 
numeric representation of that snow color, you can see that there is 
too much blue. As you adjust the colors to reduce the blue, you can 
watch the numbers in the result color swatch to see when you have 
achieved a neutral color, as represented by a color where the red, 
green, and blue values are all roughly equal.

To sample a color, click on the Sampler eyedropper button. Move the 
cursor to the Image pane and the cursor will become an eyedropper. 
Click and hold down on the mouse button. As you move the cursor 
over the image, you’ll see that the sample color swatch in the Color 
Info Window is continually updated. Likewise, the result color swatch 
is also updated, reflecting what the sampled color will appear like after 
the current correction settings are applied to it. When you locate the 
color you wish to sample, release the mouse button.

Normally, the eyedropper samples the color from a single pixel. In 
image areas with a great deal of image detail, it can sometimes be 
hard to locate a single pixel which is representative of the image 
area’s color. If you press and hold down the shift key while selecting a 
color, Color Finesse will average the color from a three-by-three pixel 
sample. Hold down the option key (Mac) or control key (Windows) 
while selecting a color and get a five-by-five pixel sample. If you hold 
down shift + option (Mac) or shift + control (Windows), Color Finesse 
will average the color from a nine-by-nine pixel area.

There are times when you want to sample a specific color, based on 
its numeric color values. To do so, hold down the option key when 
initially clicking the eyedropper button. Instead of letting you pick a 
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sample from the image, this will instead call up the standard system 
color picker, letting you choose a specific color.

The display format popup menu allows you to select the numeric 
format used to display sampled colors. You have a choice of RGB in  
8-, 10-, and 16-bit integer formats, floating point, percentage, and hex 
(web) formats. You can also display the color as a numeric HSL value. 
All of these formats report the same information, but you can choose 
the format you are most comfortable with, or that matches other 
color specifications you are working with.

One of the ways to correct colors is to use Color Finesse’s color 
matching functions. This feature, part of most of the basic color 
correction panes, allows you to choose a source and target color, and 
to have Color Finesse automatically set the controls so that the source 
color is corrected to match the target color. The exact way in which 
the match is achieved, and how it will affect other colors in the 
image, depends on the Settings Window pane in which you apply 
color matching. More details on this are discussed in the following 
chapters.

To perform color matching, first choose a source color by using 
the Sampler eyedropper, as discussed above. Then choose a target 
color using the Target eyedropper. Now choose a matching method 
from the Match Method popup menu. The contents of this menu 
will depend on the currently selected Settings Window pane. (See 
the detailed discussion on each pane in the following chapters for 
details.) Click the Match Color button and the control settings will be 
adjusted to achieve the color match.

Color Finesse provides for the use of LUTs (lookup tables) with all of 
the previews it creates. Individual LUTs can be assigned to the preview 
image, external preview monitor, and secondary preview monitor 
using the View menu in the menu bar.

LUTs are typically used to calibrate display monitors so that what 
you see on that monitor matches your final output. For example, if 
your project is destined for film output, a LUT can be used to alter the 
appearance of your external video monitor such that it matches the 
look of the final film out.

Color Display Format

Color Matching

Image Preview LUTs



	 26	 Color Finesse Fundamentals

Color Finesse supports numerous formats for LUT files, including 
Color Finesse’s own Preview LUT (.lut) format, Photoshop arbitrary 
map (.amp) files, Quantel iQ 1-D LUT (.txt) files, and Discreet 1-D LUT 
(.lut) files.

To load a 1-D LUT file for previewing, use the View menu in the menu 
bar and choose the preview device for which you wish to load a LUT. 
Color Finesse includes a number of built-in preview LUTs, or to load a 
LUT from a file, choose Other.

Choose the format of the LUT file you wish to load from the 
popup menu and select the LUT file. Click Load and the LUT will 
immediately be loaded.

To return to a neutral LUT, choose None for the LUT in the preview 
device’s LUT selection.

You can create LUTs in Photoshop and many other image processing 
and compositing applications—taking advantage of Color Finesse’s 
support for different LUT formats—or you can create the LUT directly 
in Color Finesse.

To create a LUT using Color Finesse, load a suitable sample image—
such as a test chart—and display it on the preview device you wish 
to build a LUT for. Adjust the color correction controls so that the 
image on the preview device looks the way you want it to. Then use 
File>Export>Color Finesse Preview LUT to save the adjustments as a 
LUT file. That LUT file can then be loaded as described in the previous 
section.

Because preview LUTs are 1-D LUTs, color adjustments you make 
when creating the LUT are restricted to using the RGB, CMY, YCbCr, 
Levels, and Curves controls. If you make adjustments with other 
controls, they will not be stored correctly in the preview LUT and the 
results of that LUT will be unpredictable.

In addition to 1-D preview LUTs, Color Finesse can also create 3-D 
LUTs in a variety of formats, including Academy LUT, Autodesk (in 
Lustre, Flame, Smoke, and generic flavors), Blackmagic HDLink Pro, 
Pogle, Scratch, Truelight Cube, Panavision GDP, Thomson LUTher, 
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and Cinetal formats. Use the File>Export command to choose the 
format of LUT to save.

Color Finesse can export 3-D LUTs, but is not able to import them.

When Color Finesse performs its image processing, it performs the 
operations in a specific order. That order is, roughly speaking, down 
the list of Settings Windows panes, from top to bottom. By knowing 
the processing order, you can better understand the correction results, 
and can better take advantage of the ability to use multiple 
corrections to the same image.

The exact order is:

1.	 Levels pane, input section, including highlight recovery.

2.	 HSL controls, master, highlights, midtones, shadows.

3.	 Hue Offsets.

4.	 RGB controls, master, highlights, midtones, shadows.

5.	 CMY controls, master, highlights, midtones, shadows.

6.	 YCbCr controls, master, highlights, midtones, shadows.

7.	 Curves pane, starting with RGB then HSL.

8.	 Levels pane, output section.

9.	 Secondary correction.

10.	Limiter.

Processing Order
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The Reference Gallery and 
Analysis Window

4

The Reference Gallery pane (located in the Analysis Window) 
contains a list of images that can be used as references when judging 
color accuracy or when color timing footage, as well as a list of presets 
that can be used for color correction. The reference images can be 
displayed in either the Analysis or Image windows, and can be 
displayed as a split screen with the correction result image.

When you first open the Color Finesse full interface from within After 
Effects, the Reference Gallery will contain all the still image footage 
items that are included in your After Effects project, as well as any 
images you’ve previously explicitly added to the Reference Gallery.

When using Color Finesse from other applications (such as Final Cut 
Pro or Premiere Pro), no footage items will be imported automatically, 
due to lack of support for that function in those applications. Instead, 
you will see whatever images you’ve added previously.

The Reference Gallery
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The Gallery will also contain two folders containing presets: one for 
System presets that are supplied with Color Finesse, and one for User 
presets that you’ve created and saved.

To add additional images to the Reference Gallery, click the New 
Document button in the lower left corner of the Reference Gallery 
pane. Choose one or more images from the displayed list and click 
Import. The images will be loaded into the Gallery.

The list of images you create in the Reference Gallery is stored across 
projects so that it is available whenever you use Color Finesse. This is 
handy when doing color matching across several projects.

You can also add the currently displayed image to the Reference 
Gallery by choosing Save Reference Image from the Clip menu. 
You will be asked for a name to use for the image file on disk; the 
image will be saved under that name and automatically added to the 
Reference Gallery. 

To remove an image from the Reference Gallery, select the image 
within the list and click the Delete button in the lower left corner of 
the Gallery pane. This only removes the image from the Reference 
Gallery, and does not actually delete the image file from the disk.

To select one of the images in the Reference Gallery as the current 
reference image, you can either double-click on the Gallery entry you 
wish to choose, or select the item (by clicking on it) and then clicking 
the Reference button in the lower left corner of the Reference Gallery 
pane.

Once an image is selected as the current reference image, the 
Reference Image pane will automatically be selected in the Analysis 
Window. The image will also be available in the Image Window for 
display as a complete image, or as a split screen display with the 
corrected result image.

You can organize the Reference Gallery as you see fit using folders 
within the Gallery.

To add a new folder to the Gallery, click the New Folder button in the 
lower left corner of the Reference Gallery pane. The name field of the 
new folder will be automatically selected. Enter the name of the folder 
and press return.

Adding Images
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To move reference images into or out of a folder, click the image item 
to select it and then drag the image item to its new location.

To delete a folder from the Gallery, click the folder to select it, and 
then click the Delete button in the lower left corner of the Gallery 
pane.

Folders are used to organize items in the Reference Gallery and do not 
correspond to folders on disk.

The Reference Gallery is also used to store saved color correction 
settings. There is one folder, Settings Presets (System), which is always 
present and contains presets that are supplied with Color Finesse. 
There is another folder, Settings Presets (User), which contains any 
presets you have saved.

To save the current color correction settings as a preset in the Gallery, 
you can select Save User Preset from the Settings menu or you can 
click the Save User Preset button in the lower left corner of the 
Gallery pane. You’ll be asked for a name for the preset. Choose a 
name and click OK. The current settings will be saved as a preset in 
the Settings Presets (User) folder.

To use a preset, locate the preset you want to use within the Gallery. 
Double click on the preset item and the settings will be loaded from 
the preset to the correction controls.

The Reference Gallery pane can be customized to fit your specific 
preferences. You can change the width of the columns by clicking and 
dragging on the column separators. You can change the order of the 
columns by clicking and dragging on the column titles.

The comment field is for your use in annotating the list entries. 
Double-clicking on the comment field will select it for text editing. 
Enter whatever text you find useful.

Clicking a column title will sort the reference image list based on that 
column. Clicking on the sort order button above the vertical scroll 
bar will toggle between ascending and descending sort order.

The Analysis Window provides a number of displays that provide 
objective measurements of the image you are correcting. While the 
way the corrected image looks is the final criteria, it’s also important 
to be able to measure the image so that you can ensure proper levels, 

Using Saved Settings 
Presets in the Gallery

Customizing the Gallery

Analysis Window 
Displays
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compare colors, ensure that colors are neutral, and analyze the image 
to better plan your correction strategy.

The displays in the Analysis Window reflect whatever pane is 
currently selected in the Image Window: if you have the Result pane 
selected in the Image Window, the waveform monitor’s display will 
represent the corrected result image. If you select the Source pane, the 
waveform monitor will represent the unmodified source image. When 
a split screen pane is selected in the Image Window, the Analysis 
Window display will be based on the corrected result image.

The Analysis Window offers a number of waveform monitor panes, all 
based on different styles of traditional waveform monitors. 

•	 The Luma WFM displays just the luma content of the selected 
image. Choose the display format you are most familiar or 
comfortable with.

•	 The YC WFM display overlays that with the chroma display, 
letting you see the minimum and maximum extent of the 
chroma information, as it would be encoded in a composite 
video signal.

•	 The RGB WFM display shows the levels of the separate red, 
green, and blue color channels, arranged left to right in a 
“parade” format. An option for GBR ordering is also available.

Waveform Monitor
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•	 The YCbCr shows the Y (luma) and Cb and Cr color 
component channels, also arranged left to right in a “parade” 
format. 

•	 The YRGB format adds the luma level to the RGB parade. And 
the Overlay WFM  shows the three primary color channels 
(red, green, and blue) overlaid on top of each other so you can 
see the overall effect of the video signal.

For the waveform monitor displays to be accurate, you must configure 
Color Finesse’s preferences to reflect your video system and the 
coding used by the image you are correcting.

Additional information on using the waveform monitor can be found 
in Appendix C.

The Vectorscope pane provides a traditional way of examining color 
levels and saturation.

For the vectorscope display to be accurate, you must configure Color 
Finesse’s preferences to reflect your video system, the coding used 
by the image you are correcting, and whether you wish to have the 
vectorscope calibrated for 75% or 100% color bars. See “WFM/VS 
Preferences” in the next chapter for additional details.

You can zoom the vectorscope display using your mouse’s scrollwheel, 
or by right-clicking on the vectorscope display and choosing 

Vectorscope
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the zoom factor from the popup menu. You can also select the 
vectorscope calibration (75% or 100%) using the popup menu.

Additional information on using the vectorscope can be found in 
Appendix C.

The Histogram pane shows the distribution of pixel values over the 
entire image, as separate luma (the white display), red, green, and 
blue histograms.In addition to the graphical representation, Color 
Finesse displays numerical statistics for each channel, including the 
minimum and maximum values seen, the mean value, and the peak 
value (the value with the most samples). The mean is also shown on 
the graphical histogram as a small triangle under the histogram 
display.

The Level Curves pane provides an easy-to-understand way to see how 
the red, green, and blue image channels are being manipulated by 
your image correction settings.

Histogram

Level Curves
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The display contains four colored lines representing the luma (the 
white line), red, green, and blue channels. The horizontal axis 
represents the input pixel value on a scale of 0.0 to 1.0. The vertical 
axis represents the output pixel value, also on a scale of 0.0 to 1.0.

The Combo Display pane combines your choice of four displays into 
one display. While the displays are smaller, it’s often convenient to be 
able to see all of that information without needing to switch between 
different panes.

You can select which display appears in each quadrant either in 
the Preferences’ Combo tab, or by right-clicking in the quadrant 
and choosing the desired display. When clicking in the vectorscope 

Combo Display
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display within the Combo Display you can also select vectorscope 
zoom and calibration options.

Note that in the Combo Display the histogram numerical statistics 
may not be displayed if doing so would make the graphical display 
impractically small. Whether or not this occurs depends on the 
resolution of your computer monitor. Color Finesse optimizes its 
display sizes to get as much information as possible onto the monitor, 
but may sacrifice the numerical information in the Combo Display to 
do so. The numerical information is always available in the Histogram 
pane.
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Preferences 5

Color Finesse allows you to alter a number of the ways in which it 
operates via its preferences. You open the Preferences window by 
selecting Preferences from Color Finesse’s Edit menu or by pressing 
Command + comma (Macintosh). The Preferences window contains 
several panes which you can select by clicking on the pane’s tab.

Within the General references pane you can select the number of 
undo/redo levels available. Increasing the number of levels also 
increases the amount of memory required by Color Finesse, but 
provides a greater level of protection when experimenting with 
settings. The default 20 levels is sufficient for most purposes.

The Display Tool Tips option determines if Tool Tips are displayed 
when the cursor hesitates over a control within the Color Finesse full 
interface. The default is to have Tool Tips enabled.

General Preferences



The Keep UI Running option determines if the Color Finesse interface 
remains active after you return to the host application (After Effects, 
Final Cut Pro, etc.). Keeping the full interface active reduces the time 
it takes to call up the UI, but when the UI is active it continues to 
occupy memory. The UI stops running if it isn’t used for 10 minutes. 
The default is to keep the UI active.

If you are using Color Finesse on a multiple processor system, you’ll 
have the option of disabling the use of multiple processors. Because 
it improves performance, you’ll normally want to keep multiple 
processors enabled, which is the default setting. Changing this setting 
will not take effect until the next time you start the Color Finesse user 
interface.

When using Color Finesse in broadcast situations, you will most likely 
want the Limiter to always be on. In film applications, you probably 
want it off. You can select whether the Limiter defaults to being on 
or off via a checkbox. Note that this checkbox determines the default 
setting in both the Color Finesse full interface, and in the plug-in 
simplified interface.

You can also select the default panes which are displayed when you 
first invoke the Color Finesse full interface. Choose the panes you use 
most frequently.

You can adjust the overall brightness and saturation of the Color 
Finesse full interface using the UI Brightness and UI Saturation sliders. 
This lets you tailor the interface to your specific preferences and 
viewing environment. To return these settings to their factory default 
settings, click the Default button.

The Video System pane allows you to specify the coding specifics of 
the images you are color correcting. These settings must match the 
coding of the images for the waveform monitor, vectorscope, and 
limiter to be accurate.

Choose the video system you are correcting for: NTSC, PAL, digital 
HD (709), or analog HD (240M). This tells Color Finesse the 
acceptable limits for the limiting operation, as well as selecting the 
proper waveform monitor calibration. Note that the analog HD 
(240M) system is obsolete and will rarely be used.

Video System Settings
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Also choose the image coding. In most cases when working with After 
Effects, you’ll want to use the 0-255/0-1023 setting. Use this setting 
if 0 represents black and full scale represents white, whether you are 
dealing with 8- or 16-bit images. Choose 16-235/64-940 if you are 
using images with headroom built into the encoding. Note that this 
setting does not affect the bit depth of the calculations or display, 
it simply tells Color Finesse what digital values represent black and 
white.

Select whether your images assume that the black level includes a 7.5 
IRE setup. This setting affects the waveform monitor calibration and 
the limiter.

The WFM/VS pane provides ways to customize the waveform monitor 
and vectorscope displays. Choose whether the waveform monitor 
uses a traditional green display, or uses the image’s colors. Select 
whether you want the waveform monitor calibrated in percentage 
(IRE), or in mV. Also choose whether you want the vectorscope 
calibrated for 75% or 100% color bars. The default is green waveform 
display using percentage (IRE) units, with the vectorscope calibrated 
for 75% bars.

Color Finesse 3 offers many previewing options beyond the display 
on the main monitor.

If you have an appropriate external video device, you can use it 
to display preview images on a broadcast monitor. Color Finesse 
supports a number of video output devices, such as the AJA Kona and 
Blackmagic DeckLink devices, as well as FireWire/DV devices on the 
Macintosh. It supports Blackmagic DeckLink and other devices under 
Windows. (For a current list of which previewing options are available 
on your computer platform, see the Support section of our web site.)

To select a video preview device, select it from the External Preview 
Device popup. This popup will list all preview options available on 
your system. Once a device has been selected, choose the desired 
mode from the External Preview Mode popup.

If you are color correcting footage that has different dimensions than 
your preview monitor, you may want to select appropriate scaling and 
aspect ratio conversion from the popup menus.

WFM/VS Preferences

Previews
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Note that some host applications (notably Apple Final Cut Pro) do not 
release their hold on the video preview hardware before switching to 
the Color Finesse user interface. In such cases it will be necessary for 
you to manually release the hardware before invoking Color Finesse. 
This switching is handled automatically in Adobe After Effects.

If you have more than one computer monitor connected to your 
system, Color Finesse allows you to use one of those extra monitors 
as a secondary preview monitor, which will display a full-size preview 
image. You can select the computer monitor to use as your secondary 
preview monitor using the Secondary Computer Monitor Preview 
popup menu. Select None if you do not wish to use the feature.

If you are working with the optional control surface, use this tab to 
define the type and connection method of the control surface. If you 
are working with a Colorociter CS-1 by itself, choose Standalone 
Colorociter in the popup. If you are using a Colorociter slaved to 
another device, such as a VTR jog-shuttle control, choose Slave 
Colorociter.

If the Colorociter and computer lose their connection—such as when 
the USB connection is accidentally disconnected—you can click Reset 
Control Surface to re-establish the connection and get the control 
surface and the computer back in sync.

To assign custom actions to the controls on the control surface, click 
Define Actions.

You can select which displays are shown in the Combo Display by 
selecting a display for each quadrant. Choose the display and its 
location using the popup menus.

Color Finesse makes use of a disk cache during Rapid Preview 
operations. Select the location of that disk cache using the Caches 
preferences tab.

For best Rapid Preview operation, the cache should be located on a 
fast disk—a disk array if available—with a large amount of free disk 
space.

The default cache location is in your temporary folder on the boot 
disk drive.

Control Surface

Combo Display

Caches
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HSL Color Correction 6

Using HSL (Hue-Saturation-Lightness) controls is a convenient way to 
perform many common color correction tasks since they manipulate 
the image in a way that feels “intuitive” compared to some other 
controls.

When you first click on the HSL tab, you’ll see that there are two 
different types of HSL correction available: a Controls pane and a Hue 
Offsets pane. The Controls pane contains a series of sliders you use to 
adjust things like hue, saturation, brightness, and contrast. The Hue 
Offsets pane contains color wheels that allow you to “drag” the image 
colors towards a hue. Both the Controls and Hue Offsets panes allow 
you to affect the entire image, or just portions of the image based on 
whether they are highlights, midtones, or shadows.

When you’ve selected the HSL Controls pane, you’ll see a variety of 
slider controls and tabs that allow you select whether the controls 
affect the entire image (Master), or just the highlights, midtones, or 
shadows.

The Hue controls change the image’s hue without modifying its 
saturation or lightness. Watch the vectorscope display in the Analysis 
Window and you’ll see the display rotating as you move the Hue 
control, rotating the colors around the color wheel.

HSL Controls Pane

Hue
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This control adjusts the saturation or “strength” of the colors. The 
default value is 100.0 which doesn’t alter the saturation. When set to 
0 all color is removed.

Color Finesse allows you to set negative values with the Saturation 
control by manually entering them as textual values, which has the 
effect of both adjusting the saturation and also reversing the colors 
into a negative appearance.

The Vibrance control also adjusts the saturation or “strength” of 
colors, but limits the range of the adjusted colors to avoid the 
cartoon-like appearance that colors can acquire when using large 
values of the Saturation control. This allows you to increase the 
“vibrance” of the colors in your image while still maintaining a 
natural appearance.

The Brightness control adjusts an image’s “brightness” by division so 
that darker pixels are affected more than lighter pixels. If you adjust 
this control and watch the Level Curves in the Analysis Window, 
you’ll see that white pixels are not affected, while darker pixels are 
progressively more affected. This effectively raises the black point.

The Contrast control alters the way the image information is spread 
between pure white and pure black, thus altering the image contrast. 
Color Finesse uses a contrast curve, rather than the simple linear 
contrast adjustment used by some other color correction tools. This 
gives a more “natural” look to the adjustments, but does mean that it 
may make it behave differently than you are accustomed to.

When you adjust the Contrast control with the Contrast Center 
control at its middle (default) position, image values are affected 
based on how far they are away from the center point between black 
and white. By adjusting the Contrast Center control, you can change 
how the image values are altered by shifting the adjustment towards 
white (positive control values) or towards black (negative control 
values). 

RGB Gain adjusts an image’s “brightness” by multiplication so that 
lighter pixels are affected more than darker pixels. If you adjust this 
control and watch the Level Curves in the Analysis Window, you’ll 
see that black pixels are not affected, while lighter pixels are 
progressively more affected. This effectively raises the white point.

Saturation

Vibrance

Brightness

Contrast and Contrast 
Center

RGB Gain



The Gamma slider allow you to perform what is known as “gamma 
correction.” This adjusts the midtone values of the image while not 
affecting the black and white levels. It is a common adjustment to 
make when an image is “too light” or “too dark” as it can solve those 
problems without distorting the image’s shadows and highlights.

Pedestal correction changes an image by adding a fixed offset to the 
image’s pixel values. While you can use it to boost an image’s overall 
brightness, doing so will also make the blacks brighter, potentially 
making them gray. Pedestal correction is often used in conjunction 
with gain correction.

When you are color  correcting an image, you may want to alter the 
colors in the entire image, but there are many times when you need 
to change just the highlights or shadows, such as when correcting 
shadows in a snow scene while leaving the highlights unchanged, or 
when removing color casts caused by mixed lighting.

Color Finesse provides for this by offering the ability to make 
adjustments to image areas based on where they fall in the tonal 
range of highlights, midtones, or shadows.

Within the HSL Controls (and Hue Offsets, and the RGB, CMY, and 
YCbCr channel controls) Color Finesse offers both Master controls—
which affect the entire image—and controls for each of the tonal 
ranges: Highlights, Midtones, and Shadows.

Gamma

Pedestal

Tonal Corrections
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To preview what  portions of the image will be considered to be 
highlight, midtone, or shadow, use the Luma Ranges pane in the 
Image Window. Shadow areas will be shown as black, midtones as 
gray, and highlights as white.

Color Finesse defaults to tonal range definitions—what constitutes a 
highlight, midtone, or shadow—that are suitable for most “typical” 
images. However, if your image is shifted towards highlight or 
shadows, or has a very narrow range of values that should be 
considered midtones, you can alter the tonal range definitions to best 
suit your image. To adjust the ranges, select the Luma Ranges pane 
and you’ll see the following display.

The Luma Ranges display combines a histogram showing the 
distribution of luma ranges in your image, with curves showing the 
extent of the highlight, midtone, and shadow areas, with control 
handles which allow you to alter the definitions.

Luma Ranges Preview

Defining Tonal Ranges
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To adjust the shadow range, click and hold on the tip of the leftmost 
yellow control handle. While holding the mouse button down, move 
the cursor and you’ll see that you can alter the shape of the shadow 
curve. As you alter the area considered shadow, you’ll also change the 
area considered to be midtones. This is because any area not either a 
shadow or highlight is by definition a midtone.

You can grab the highlight control handle and adjust the highlight 
definitions in the same way.

If you have the Luma Ranges preview pane selected in the Image 
Window, you’ll see the preview updated as you change the luma 
range definitions, making it easier to get the result you want.

Color Finesse supports color matching using the HSL Controls pane. 
Select the sample and target colors using the Color Info Window. 
Then select the channels you wish to match from the Match Method 
popup menu in the Color Info Window. Click the Match Color 
button and Color Finesse will adjust the controls as needed to achieve 
the selected match.

In most cases you’ll specify H+S+L as the match method, as that will 
achieve a true color match. However, you can match any individual 
channel or combination of channels by choosing the appropriate 
color matching method from the popup.

Matching on just the hue can adjust for incorrect color temperature 
without altering image brightness or contrast. Matching on just 
saturation can be useful when you’ll be intercutting footage from two 
cameras where the saturation doesn’t match.

Color matching with the HSL Controls pane may not always be able 
to achieve a perfect color match, because Color Finesse is somewhat 
limited in the range of adjustments it can make with those controls. 
If this is not suitable for the match you are trying to achieve, consider 
using color matching within the Curves pane, as its ability to match 
on the red, green, and blue channels gives more flexibility, although 
it may give a more “perfect” but not as “pleasing” color match. See 
Chapter 8, “Curves Correction,” for more information.

The Hue Offsets pane provides controls for adjusting hue and 
saturation values at the same time by using color wheels, or slider/

Color Matching

Hue Offsets Pane
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text controls. These controls are most commonly used for adjusting 
color casts in images.

The Hue Offsets pane is divided into four color wheels, with 
corresponding slider controls, that correspond to the master, shadow, 
midtone, and highlight controls. They adjust the same tonal ranges as 
the Hue controls.

To use one of the color wheels, use the cursor to click and hold on the 
central black square. With the mouse button still down, drag that 
control to one side. If, for example, you dragged the control towards 
the blue side of the color wheel, the image would have taken on a 
blue cast. The further from the center you drag, the stronger the blue 
cast will become. As you move the control around the color wheel, 
the hue applied to the image will change.

For more control over dragging within the color wheel, hold down 
the shift key as you drag. This will increase the resolution of your 
mouse moves by ten times. That is, you’ll need to move the mouse 
ten times as far to make the same change in the color wheel setting. 
This is useful when making small changes to the settings.

In addition to dragging the control on the color wheel, you can 
perform the same operations by using the Hue and Strength sliders, or 
entering numeric values into the Hue and Strength text fields.

As you drag the control on the color wheel, you may also want to 
watch the vectorscope display in the Analysis Window so that you 
can see how the vectorscope responds to the color wheel control. It is 
often an ideal way to judge when an image has had a particular color 
cast neutralized.

Using the Color Wheel
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You can reset all of the color wheels, or individual wheels, to their 
default settings. To reset all wheels, click the Reset button located 
within the Hue Offsets settings pane. To reset an individual wheel, 
right click or—on a Mac with a single-button mouse—hold down 
control and click within the display area of the wheel you wish to 
reset. Choose Reset Hue Wheel from the contextual menu which 
appears and release the mouse button.
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Color Channel Correction 7

A common style of color correction is to adjust individual color 
channels. Color Finesse supports this by offering three different color 
models of channel correction.

The RGB (Red-Green-Blue) color model is probably the most familiar 
as it’s the internal format used by computer displays and the most 
common mode used in image editing applications such as Photoshop. 
As such, it’s the most common color space people think of when 
thinking of “color channels.”

Color Finesse allows you to manipulate the gamma, pedestal, and 
gain of each of the red, green, and blue color channels, as well as 
manipulate all three channels simultaneously.

The Gamma sliders allow you to perform what is known as “gamma 
correction.” This adjusts the midtone values of the image while not 
affecting the black and white levels. It is a common adjustment to 
make when an image is “too light” or “too dark” as it can solve those 
problems without distorting the image’s shadows and highlights.

Pedestal correction changes an image by adding a fixed offset to the 
image’s pixel values. While you can use it to boost an image’s overall 
brightness, doing so will also make the blacks brighter, potentially 
making them gray. Pedestal correction is often used in conjunction 
with gain correction.

RGB Correction

Gamma Correction

Pedestal Correction
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Gain correction adjusts an image’s “brightness” by multiplication so 
that lighter pixels are affected more than darker pixels. Combine it 
with pedestal correction if you also want to affect dark pixels.

Color Finesse’s RGB pane also lets you make adjustments based on 
whether an area is considered to be a shadow, midtone, or highlight. 
This can be particularly useful when dealing with, say, a snow scene 
where the shadows are too blue, but the highlights are correctly 
white. If you adjust all tonal ranges of the image to remove the excess 
blue, the white highlights will also be affected and will become too 
yellow.

By using the tonal ranges, you can remove the blue from the shadows 
without affecting the highlights.

More detail on tonal corrections, and how you can define what Color 
Finesse considers a shadow, midtone, or highlight, can be found in 
“Luma Ranges Preview” in the previous chapter.

While it’s normally associated with printed material, the CMY (Cyan-
Magenta-Yellow) color model can also be useful for correcting other 
materials. Film negatives are based on cyan, magenta, and yellow dye 
layers, which may fade at different rates. Correcting for that fading is 
often more intuitive when the correction controls work in the same 
color model. In addition to correcting old faded film, CMY correction 
also makes it easy to create the look of old faded film.

It’s also easier to correct an image that appears to be too yellow by 
reducing the yellow in CMY space, than it is remembering your color 
complements and reducing both the red and green channels in RGB 
space, even though both will have exactly the same effect on the 
image. For many correction operations, CMY is simply more intuitive.

Gain Correction

Tonal Correction

CMY Correction
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As with RGB, CMY gives you control over the gamma, pedestal, 
and gain of each of the color channels. Refer to the section on RGB 
Correction at the front of this chapter for more information on the 
effect of these controls.

Color Finesse also gives you control over the CMY channels based 
on tonal ranges. More detail on tonal corrections, and how you can 
define what Color Finesse considers a shadow, midtone, or highlight, 
can be found in “Luma Ranges Preview” in the previous chapter.

YCbCr (component color) correction treats the image as luma 
information and two color components. This lets you adjust just the 
luma information without altering the color at all. It also lets you 
adjust the colors without altering the luma values. YCbCr is also the 
format that is used to record analog and digital component video, so 
it can be a useful mode for correcting problems that occurred with 
your original video source material.

Adjusting the Y controls manipulates the luma values of the image 
without affecting the color values.

When you adjust the Cb controls, you are moving color values along 
a roughly yellow-blue color axis. Adjusting the Cr control moves 
values along a roughly red-green axis. (The axes do not align perfectly 
with yellow-blue/red-green, but are visually similar to those axes, so 
it’s a convenient way to think of them.)

As with RGB, YCbCr gives you control over the gamma, pedestal, 
and gain of each of the color channels. Refer to the section on RGB 
Correction at the front of this chapter for more information on the 
effect of these controls.

YCbCr Correction
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Color Finesse also gives you control over the YCbCr channels based 
on tonal ranges. More detail on tonal corrections, and how you can 
define what Color Finesse considers a shadow, midtone, or highlight, 
can be found in “Luma Ranges Preview” in the previous chapter.

Note that Color Finesse is actually always dealing with RGB data 
because that’s what it’s supplied by the host application (After 
Effects, Final Cut Pro, etc.). When doing YCbCr correction, Color 
Finesse is converting to and from the component color format. 
While Color Finesse is doing this entirely in floating-point and is 
thus able to eliminate many of the rounding errors associated with 
such conversion in other software, remember that the YCbCr color 
space is smaller than the RGB color space, thus causing some loss of 
highly saturated colors. For video use this will be invisible—video 
gets converted to component color format in any case—but it may 
be visible when dealing with RGB images destined for non-video use, 
such as film or the web.

Color Finesse supports color matching using any of the channel 
correction methods. Select the sample and target colors using the 
Color Info Window. Then select the channels you wish to match from 
the Match Method popup menu in the Color Info Window. Click the 
Match Color buttons and Color Finesse will adjust the controls as 
needed to achieve the selected match.

In most cases you’ll specify R+G+B, C+M+Y, or Y+Cb+Cr as the 
match method, as that will achieve a true color match. However, you 
can match any individual channel or combination of channels by 
choosing the appropriate color matching method from the popup.

Matching on the Cb+Cr channels within the YCbCr pane is often 
useful as it will adjust the color components without altering image 
brightness.

Color matching within the channels settings panes will alter the 
black and white points as well as the colors. If this is not suitable for 
the match you are trying to achieve, consider using color matching 
within the Curves pane. See “Color Matching” in the next chapter for 
more information.

Color Matching
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Curves Correction 8

The Curves correction panes allow you to control color by placing 
control points on curves and then adjusting the curves. Color Finesse 
supports two types of curves: RGB and HSL.

RGB Curves make adjustments based on the RGB color channels.
You can adjust a control curve for the master channel, or for any 
combination of the individual red, green, and blue channels.

In addition to manually placing and adjusting control points, the 
RGB Curves pane allows you to automatically adjust the curves to 
achieve black, white, or gray balance, match colors, or load existing 
curves previously defined in either Color Finesse or Photoshop.

HSL Curves work based on hue rather than color channel. The range 
of color hues is arranged along the horizontal axis, with the three 
curves having hue, saturation, and lightness along the vertical axes, 
respectively. This allows you to adjust the hue, saturation or lightness 
of pixels based on their color (hue).
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HSL curves can be used, for example, to select the green of foliage and 
adjust its hue and saturation to change the apparent season, turning 
bright green springtime leaves a more fall-like yellow.

Both RGB and HSL curves can be manipulated in the same way. 
Correction curves can have up to 16 control points, letting you create 
complex adjustments which can easily be adjusted by moving the 
control points.

To move a control point, move the cursor over the point you wish to 
move. You’ll see the cursor change from a cross to a four-headed 
arrow, indicating that it has “captured” the nearest control point. 
Click and hold down the mouse button and move the control point 
as you wish. The curve will be updated as you move the cursor. Once 
you are satisfied, release the mouse button.

You can have up to 16 control points on a given curve. To add an 
additional point, position the cursor on the place where you wish to 
add the new point. Click and hold down the mouse button to add the 
new point. You can then continue holding the mouse button down 
and position the newly added point where you want it. Release the 
mouse button to complete the operation.

Sometimes you wish to add a new point very close to an existing 
control point. This can be problematic because Color Finesse will 
attempt to move the existing point, rather than add a new one. To 
work around this, add a new control point away from the existing 
point, then move the newly added control point into position.

To delete an existing control point, position the cursor on the point 
and click once to select the point. The selected point will change from 
a hollow square to a solid square, indicating that it has been selected. 
Once the point is selected, press the delete key to remove the point 
from the curve. There must always be at least two control points to 
define the ends of the curve, so you will not be able to delete those 
final two points.

Adjusting Curves

Moving a Control Point

Adding a Control Point

Deleting a Control Point



Alternatively, select the control point you wish to delete and 
hold down the control key while clicking (Mac) or right-clicking 
(Windows) on the point. A contextual menu will appear which will 
give you the option of deleting the selected point.

In addition to manually adjusting the curve shapes to achieve the 
correction you want, using the RGB curves you can have Color 
Finesse set points required to achieve black, gray, and white balance 
for portions of the image you choose.

To set both black balance and black level, click on the black-filled 
eyedropper in the lower left of the Curves settings pane. Move the 
cursor to the image pane and the cursor will change to an eyedropper. 
Click the mouse button on the portion of the image you wish to have 
adjusted to black. When you release the mouse button, the curves will 
be adjusted such that the image sample you selected will be properly 
black balanced.

Setting white balance for the curves is done the same as for black 
balance, but start by clicking on the white-filled eyedropper button 
instead.

When setting gray balance, start by clicking the gray-filled eyedropper 
button. Then sample a point in your image which should be neutrally 
colored. Color Finesse will then adjust the curves so that the selected 
image sample will balance the red, green, and blue channels to be 
neutral. For best results, you should sample a portion of the image 
that is roughly a middle gray; choosing a very dark or very light 
image sample will not yield as smooth of a gray balance.
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In addition to manually adjusting the correction curves, you can load 
a previously defined set of RGB curves from a file. These curves could 
have been previously defined and saved from Color Finesse, or could 
have been defined and saved from Photoshop or other applications 
which save compatible curve definitions.

Color Finesse supports loading curves from a variety of file formats, 
including Photoshop curve (.acv) and arbitrary map (.amp) files, 
Discreet 1-D LUT (.lut) files, and Quantel iQ 1-D LUT (.txt) files.

To load a set of curves, click the Load... button located within the 
Curves settings pane. Select the format and file to load from and click 
Load.

To save a set of curves for later use, click the Save... button located 
with the Curves settings pane. Select the name for the file and click 
Save.

You can also load and save curves via the contextual menu. Right 
click or—on a Mac with a single-button mouse—hold down control 
and click within the curve display area and choose Load Curves or 
Save Curves from the menu.

Color Finesse always saves and loads the settings for all curve 
channels.

You can reset all of the RGB or HSL curve channels, or individual 
channels, to their default settings. To reset all curves, click the Reset 
button located within the RGB or HSL Curves settings pane. To reset 
an individual channel’s curve, right click or—on a Mac with a single-
button mouse—hold down control and click within the display area 
of the curve you wish to reset. Choose Reset Curve from the 
contextual menu which appears and release the mouse button.

Color Finesse supports color matching using the RGB Curves pane. 
Select the sample and target colors using the Color Info Window. 
Then select the channels you wish to match from the Match Method 
popup menu in the Color Info Window. Then click the Match Color 
buttons and Color Finesse will adjust the curves, adding points as 
needed, to achieve the selected match.

In most cases you’ll specify R+G+B as the match method, as that will 
achieve a true color match. However, you can match any individual 
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channel or combination of channels by choosing the appropriate 
color matching method from the popup.

Color matching within the RGB Curves settings pane will match 
colors without modifying the black and white points, which 
differentiates it from other panes (such as HSL or RGB) which may 
alter the black and white points when matching colors.
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 Levels Corrections 9

The Levels correction pane provides a way to alter the black, white, 
and gray point of the incoming image (prior to all other processing) 
and the black and white points of the outgoing image (just ahead of 
secondary correction and the limiter). Levels corrections allow you to 
maximize image contrast by ensuring that the image takes advantage 
of the full range of pixel values available.

Buttons are also provided for having Color Finesse adjust the input 
Levels controls automatically, correcting color (removing color casts 
and performing white balance) and adjusting input black and white 
levels.

Additionally, the Levels pane lets you perform Highlight Recovery 
on the input, bringing extreme highlights into the normal, viewable 
range.

In general, you want to use as broad a range of pixel values as possible 
to preserve as much image detail as possible. Even when the final 
image is not intended to have much contrast, and may in fact have 
no pure black or white, you should consider adjusting the input 
Levels controls to create an image with a full contrast range. This 
makes the job of following correction controls easier and can help 
avoid image “mush” that can occur when trying to correct an image 
with little image contrast. After color correction, you can use the 



output Levels settings to create the black and white points you want 
in your final output image.

The Levels pane consists of both Input and Output displays. Each 
display contains a histogram representing the current distribution of 
pixel values in the image being corrected. The input histogram 
represents the image before any adjustments have been made to it. 
The output histogram represents the final output image, after all 
corrections have been performed. Because the two are linked, changes 
you make to the Input levels will affect what you see in the output 
histogram.

Below the input histogram is a grayscale with three triangular controls 
under it, one to represent the black point, one for the gray point, and 
one for the white point. Click on these controls and drag them from 
side to side to adjust them.

Below the output histogram are two triangular controls, one to 
represent the black point and one for the white point.

By selecting the appropriate channel pane within the Levels pane, you 
can adjust the master levels, or levels for the individual red, green, 
and blue channels.

When adjusting black and white point settings for the Input control, 
you are defining the points within the black-to-white range that are to 
be considered the extremes of the range. Any pixel value that falls on 
or below the black point will be converted to pure black. Likewise, 
any pixel that falls on or above the white point will be considered 
pure white. The pixel values that fall between will be “stretched” so 
that the image contains a full range of pixels from black to white.

Often you will want to set the black and white points by looking 
at the histogram and finding the upper and lower extremes of the 
histogram. Place the black point at the left-most extreme and the 
white point at the right-most extreme and you will have maximized 
image contrast.

When adjusting black and white point settings for the Output 
control, you are doing something similar to what you did with the 
input control, but you are looking at a histogram of the image after 
other correction operations have been performed. If those other 
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operations have reduced the image contrast, you can use the Output 
control to restore the contrast by resetting the black and white points.

In addition to adjusting the input black and white points, you can 
also adjust the input gray point, which will adjust the contrast of 
midtone values without modifying the black and white points.

The black and white point settings for the Output control work 
differently than the similar settings for the Input controls do. The 
black point setting for the Output control determines the pixel value 
that will be output for “black” pixels. That is, moving the black point 
to the right will increase the numeric value of any pixel which is 
considered to be black. Likewise, the white point setting determines 
the numeric value of “white” pixels.

The input Highlight Recovery provides a way to bring “whiter-than-
white” (floating point value greater than 1.0) pixels into range so that 
they are in the normal viewable range. Highlight recovery is applied 
to the image as part of Input levels processing, prior to any other 
color corrections.

You might wish to use Highlight Recovery, for example, with film 
scans (DPX files) which have blown-out highlights in windows. 
By adjusting the Highlight Recovery control, you can tame these 
highlights and reveal otherwise hidden details in the image.

Care should be exercised when using this control as setting it to too 
high a value can lead to flat, “chalky” looking highlight areas.

For controlling over-bright areas of the image after color correction, 
but before final output, use the Luma Soft Clip features of the Limiter 
control (see “Luma Soft Clipping” on page 70).

Color Finesse provides a single-button way to adjust the red, green, 
and blue levels controls to remove color casts, including white 
balance or color temperature issues.

To use this feature, choose a frame representative of the color cast you 
are trying to remove. Click the Auto Color button once to adjust the 
color channel levels. If not all of the color cast is removed, you can 
manually tweak the levels controls to finalize the settings.

If you have a situation where the white balance of your footage 
changes over time, you can take advantage of the fact that color 
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levels settings are interpolated by the Color Finesse plug-in. You 
can use Auto Color to correct the footage at the start of the footage, 
then use it again at different keyframes. The changing values will be 
interpolated, providing a smooth transition between the different 
corrections.

The Auto Exposure button works similarly to the Auto Color button, 
but sets the input black and white points without performing any 
color changes.

In general, use the Auto Color button first, followed by the Auto 
Exposure button. Using these buttons in the opposite order will give 
similar, but not identical results; choose the one which works best for 
your footage.

Auto Exposure
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Secondary Color Correction 10

Secondary color correction is the correction of selected areas of the 
image area. Because it’s done after the first round of correction, it is 
called “secondary.”

A typical use might be to select a portion of the image defined by 
its color characteristics (such as a yellow scarf or a blue sky), and 
alter that color to subtly enhance it or to radically alter it. For such 
operations you may also choose to use the HSL Curves (see “Curves 
Correction” on page 53).

Color Finesse provides the Secondary CC pane to perform secondary 
corrections. 

The Secondary CC pane provides six sub-panes, labeled A through 
F, which provide six channels of secondary correction. These can 

Basic Theory
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be used to correct up to six different parts of the image or can be 
combined to very precisely isolate one portion of the image.

To begin secondary color correction, you will need to select a region 
of the image which you wish to correct. Regions are selected based on 
a series of color samples taken from the region. You can then tune 
chroma and luma tolerance parameters so that the region 
encompasses just the area you wish.

To sample part of a region, click one of the sample eyedropper 
buttons. Move the cursor to the image and press the mouse button. As 
you move the cursor with the button down, you will see the sampled 
color update in the sample color swatch. When you have located the 
desired color sample, release the button. You can select the region for 
secondary color correction using up to four color samples. If you need 
additional samples, you can combine multiple channels of secondary 
correction.

When choosing a color sample, single pixel samples can sometimes 
be too specific and not representative of the larger area. Instead of a 
single pixel sample:

•	 To sample a 3x3 pixel area, hold down the shift key when 
clicking the eyedropper on the image. 

•	 To sample a 5x5 area, hold down the option key for 
Macintosh or control key for Windows. 

•	 To sample a 9x9 pixel area, hold down both the shift and 
option keys for Macintosh or shift and control keys for 
Windows.

Selecting a Color 
Region

Sampling
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The Show Preview button allows you to turn on and off selection 
previewing. The Preview Style popup menu allows you to preview 
your color selection in a variety of fashions. Each preview style has its 
advantages; choose the one that works best for the image you are 
color correcting.

Desaturate preview style alters the image preview so that color 
saturation is removed from all unselected portions of the image, 
leaving you with a black-and-white image with only the selection in 
color. It provides an easy way to visualize your selection, and is very 
helpful when tuning the other selection sliders.

The Mask preview style shows the image as if a “rubylith” mask was 
overlaid on it. Areas that are not selected will be tinted light red, 
while areas that are selected are left unchanged.

The Alpha preview style shows the image as a black-and-white image, 
with unselected areas shown as black and selected areas shown as 
white. Partially selected areas will be shown as gray.

The Chroma Tolerance control determines how different a color can 
be from your chosen color samples and still be considered part of the 
selected region.

If you are selecting a region with a very distinctive color (i.e., no 
other portion of the image contains a similar color) then you can 
leave the Tolerance value quite high. When an image contains many 

Preview
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colors very similar to the color you are selecting, you will need to 
tune Chroma Tolerance to a lower value.

With the Preview check box selected, the vectorscope display can be a 
helpful guide in judging Chroma Tolerance values.

The Luma Tolerance control determines how much a color can differ 
from the luma value of your chosen color samples and still be 
considered part of the selected region.

Adjust the slider until you have selected just the region you want.

The Softness control adjusts how colors that are very close to being in 
or out of the selected color area are treated. With a minimum Softness 
value, a pixel is either in or out of the selection; there is no in-
between. With higher values, pixels can be treated as partly selected.

You will want to adjust the Softness value so that there are no harsh 
edges where the selection begins.

The Invert check box reverses the sense of the selection, so that all 
pixels selected by your color samples are excluded from the image 
adjustment area, and those pixels not selected by your color samples 
will be affected by your color corrections. 

Once you isolate the portion of the image you wish to correct, Color 
Finesse provides several tools for altering the isolated area.

You can adjust the hue and saturation. Use the Hue control for 
altering the area color, making a yellow scarf red. The Saturation 
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control can be used to either subdue a too-bright color, or punch a 
color way up, such as when improving bland skies.

The Saturation control can also be used in conjunction with the 
Invert check box to isolate an area and remove color (by setting 
saturation to 0) from all other areas, leaving a colored object in a 
black-and-white world.

You can modify the gain, gamma, and pedestal of the selected area 
using the supplied controls.

The Hue Offset controls allow you to alter the hue of the selected area 
by “pulling” it towards another point on the color wheel. This can 
be used to fix mixed-lighting problems, or can be used to take a light 
blue (almost cyan) sky and move it towards a deep blue.
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When preparing video for broadcast, you’ll need to make sure that 
your images fall within certain limits. Some of these limits are a result 
of broadcasting techniques (composite levels can’t possibly exceed 
133 IRE as that would eliminate all modulation from the transmitter), 
some are regulatory limits imposed by governmental bodies, and 
some limits are imposed by broadcasters themselves, who have their 
own engineers to set such rules.

Particularly in the area of broadcaster’s limits, you’ll find that the 
rules differ greatly. For example, most broadcasters in the United 
States agree on an upper limit for the composite output levels of 
110 IRE, but differ on the lower composite limit (-20 and -30 IRE are 
common), and can’t agree at all on an upper luminance limit (usually 
somewhere around 100 IRE).

Because of these limits, the ease with which a computer can be used 
to push video beyond those limits, and the fact a broadcaster may 
refuse to air your material if it exceeds their limits, it’s in your interest 
to ensure that your material meets all requirements. Color Finesse can 
help you do that.

After color correcting footage, it is quite easy to have highlights that 
exceed acceptable broadcast limits. This is particularly true with Color 

Luma Limiting



Finesse’s floating-point calculations which let you create extremely 
bright pixels.

The Limiting pane provides two ways to deal with such bright pixels. 
The first, Luma Soft Clipping, rounds down luma values within 
settable ranges to gently roll off the highlights, eliminating the 
problem without simply clipping all out-of-limit whites.

The second method, Luma Hard Clipping, is simple white clipping 
that provides a “brickwall” solution to make sure that all luma values 
above the hard limit are eliminated.

You will normally apply both luma limiting methods: use the Soft 
Clipping to gently adjust highlights, and Hard Clipping to remove 
anything left that might be out of limits. Taking this two-tier 
approach ensures legal levels with maximum image quality.

Color Finesse’s Luma Soft Clipper lets you define the clipping 
operation using three controls: Knee Level, White Level, and Max 
Level. Each of these should be set to a value expressed in percentage 
(IRE units). This control is very useful for taming overly bright areas 
of the image resulting from your color correction settings. For taming 
highlights in the original footage prior to color correction, use the 
Highlight Recovery control in the Levels tab (see “Highlight 
Recovery” on page 61).

The Knee and Max Level controls select the minimum and maximum 
luma values that will be affected by the Soft Clipper. The White Level 
control sets the luma value that will ultimately be mapped to a pure 
white of 100 IRE.

Start by determining the highest luma level that you wish to preserve 
any detail in and set that as the Max Level. For example, if you have 
corrected an image and in the process the highlights have been 
pushed up to 120 IRE, set the Max Level to 120.

Now determine the luma level you wish to use to represent pure white 
in your image. Typically this will be 100 IRE or slightly below. Set this 
value as your White Level. A pixel whose luma is equal to the Max 
Level will be mapped to the White Level by the Soft Clipper.

Now choose the level at which the luma level adjustment is to 
begin. You typically want to set this around 80 to 90 IRE so that the 

Luma Soft Clipping
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highlight adjustment is done in just the brightest part of the image, 
without affecting the rest of it. Set the Knee Level to this value.

None of these settings are critical and it is often best to simply adjust 
them until you get a pleasing image with the highlights brought 
under control. The Hard Clipper (below) will take care of any 
remaining image areas that exceed the luma limits.

Select the absolute limit you wish to place on luma values, as 
expressed in IRE. This limit is applied after Soft Clipping which, if 
adjusted properly, should leave very few pixels for the Hard Clipping 
to deal with.

Composite color video systems superimpose the color information on 
the same signal as the luma information. This means that certain 
combinations of luma and chroma can cause the extremes of the 
composite video signal to exceed the required limits. Color Finesse 
can do chroma limiting to adjust only those image pixels that exceed 
the limits, while leaving the rest of the image unmodified.

Because the limits vary from broadcaster to broadcaster, you’ll need 
to set the chroma limiter controls to match the specifications of the 
broadcaster you are targeting. The default values have been chosen to 
be “safe,” but some broadcasters are particularly picky, so you should 
verify all limits.

Choose the maximum composite video level you will allow in IRE 
units. Any pixels with values above this limit will be limited. The 
colors that most often run into the maximum limit are bright shades 
of saturated cyan and yellow. A max limit of 120 IRE is a common 
limit and is the default.

Choose the minimum composite video level you will allow in IRE 
units. Any pixels with values below this limit will be adjusted so they 
are above the limit. The colors that most often run into the minimum 
limit are bright shades of saturated blue and red. A min limit of -30 
IRE is a common limit and is the default, although some broadcasters 
use a limit of -20 IRE.

Select the limiting method you wish to use to adjust out-of-limit 
colors. The different methods have different effects on the colors 
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being limited, so the one you choose depends in part on your image 
content.

The Reduce Saturation method tends to “wash out” colors that are 
limited to any large amount. The Reduce Luma method preserves 
colors better, but can also make colors “muddy” if too much 
correction is done. Color Finesse’s unique Smart Limit method uses a 
combination of methods to properly limit colors while best preserving 
their appearance.

Choose the video system you are outputting to. This ensures that the 
limiting will be done without any unwanted color shift.

Checking the Preview Out of Limit Chroma checkbox will cause Color 
Finesse to show any areas of the image that exceed the chroma limit 
as black. Toggling the checkbox a few times will clearly show any 
areas that are being affected by the limiter.

Video System

Preview Out of Limit 
Chroma



	 Using the Colorociter Colorist’s Workstation	 73

 Using the Colorociter 
Colorist’s Workstation

12

The Colorociter is an optional hardware control surface which can 
be used with Color Finesse to provide a tactile interface for improved 
color correction efficiency.

The Colorociter consists of four trackballs with surrounding rings, 
twelve knobs, twenty programmable buttons and two alphanumeric 
displays.

Using a control surface avoids much of the mousing and keyboard 
use normally done during correction. Controls from different settings 
panes are available without switching panes, and more than one 
control can be adjusted at once. And because you get the tactile 
feedback of using a physical control, adjustments can be made more 
quickly than when dragging a virtual slider control on-screen.

Physical installation and cabling of the Colorociter is covered in the 
manual which accompanies the Colorociter hardware.

The Colorociter support software is a separate installer which is 
included on the Color Finesse CD, and is also availabe for download. 

Installing the 
Colorociter



This software should be installed prior to connecting the Colorociter 
hardware.

Once the software is installed and the hardware connected, the 
Colorociter wiil automatically be initialized when Color Finesse 
starts up. The initialization process will light the trackballs and other 
controls of the Colorociter.

If the Colorociter does not initialize on startup, start by checking the 
hardware connections. Disconnecting and reconnecting the interface 
cable will sometimes correct problems by forcing the host computer 
to re-initialize its own connection.

If that does not correct the problem, check the software settings. 
Open the Color Finesse Preferences and select the Control Surface 
pane.

Verify that the Control Surface Type is set to Standalone Colorociter. 
Verify that the correct interface type (USB or Ethernet) is selected, and 
if an Ethernet connection is being used, verify that the IP address in 
Preferences matches the IP address selected in the Colorociter itself. 
With all settings verified, click the Reset Control Surface button to 
force a reset of the Colorociter.
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The Colorociter supports up to seven unique mappings of workstation 
controls to on-screen controls. You select the current control page 
using the seven Page buttons located at the top of the Colorociter.

Press the button corresponding to the page you want to use. The 
indicator LED next to the button will light, and the text displays and 
trackball colors will change according to the page definitions. If a 
page is not currently active, you will hear the system alert sound.

To reset a Colorociter control, press and hold the Reset button while 
adjusting the control you wish to reset, then release the Reset button.

To reset all color correction controls to their default values, press the 
Reset button twice in rapid succession, as if you were double-clicking 
the mouse button. This will reset all controls, not just those mapped 
to the Colorociter controls.

By default, the Colorociter has five of the seven control pages 
predefined. You can use the other two pages for custom 
configurations (see the following section for information on setting 
up custom configurations) and can re-configure any of the standard 
five.

For the default configurations, the four trackballs are programmed to 
behave the same regardless of which control page is selected. The 
trackballs are assigned to the four HSL Hue Offset wheel controls. The 
surrounding rings adjust the hue, while the trackballs themselves 
adjust both hue and strength. 

In addition, the six knobs and eight buttons on the right side of 
the Colorociter are also programmed to behave the same regardless 
of which control page is selected. Both these and the trackball 
definitions can be changed (see below for instructions), but they all 
perform functions that have been found to be frequently requested.

The E1 knob is used to choose the currently active pane in the 
Settings Window. Pressing down on the knob toggles between the 
current pane and the HSL pane.

The E2 knob is used to choose the currently active pane in the 
Analysis Window. Pressing the knob toggles between the current pane 
and the Combo pane.

Selecting Control 
Pages

Resetting Controls

Default Control Page 
Configurations

Common Controls
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The E3 knob chooses the currently active pane in the Image Window. 
Pressing the knob toggles between the current pane and the Result 
pane.

The E4 knob has no functions assigned to it. You can assign your own 
meaning as described below.

The E5 control adjusts the Chroma Max value in the Limiter. Pressing 
the knob toggles the Limiter on and off.

The E6 control moves the split screen point in the Split Source and 
Split Ref panes of the Image Window left to right. Pressing the knob 
has no action assigned to it and will do nothing.

The buttons G1 through G8 have been programmed to store and 
recall color correction settings as saved QuickGrades, just as can be 
done with the keyboard functions keys F1-F8.

To store the current settings for later recall, choose one of the eight 
QuickGrade buttons. Double-click the button as you would double-
click a mouse button to store the color correction settings into that 
button. You can store color correction settings in each of the eight 
buttons.

To recall the setting stored in the button, press the button. The 
correction settings will be recalled and applied to the current clip. The 
LED next to the button will indicate the currently active QuickGrade.

The three knobs under the left alphanumeric display control Master 
Hue, Saturation, and Contrast. The three knobs under the right 
alphanumeric display control HSL Master Gain, Gamma, and Pedestal.

The three knobs under the left alphanumeric display control HSL 
Highlight Hue, Saturation, and Contrast. The three knobs under the 
right alphanumeric display control HSL Highlight Gain, Gamma, and 
Pedestal.

The three knobs under the left alphanumeric display control HSL 
Midtone Hue, Saturation, and Contrast. The three knobs under the 
right alphanumeric display control HSL Midtone Gain, Gamma, and 
Pedestal.

The three knobs under the left alphanumeric display control HSL 
Shadow Hue, Saturation, and Contrast. The three knobs under the 
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right alphanumeric display control HSL Shadow Gain, Gamma, and 
Pedestal.

The three knobs under the left alphanumeric display control HSL 
Master Pedestal, Gamma, and Gain. The three knobs under the right 
alphanumeric display control control RGB Red Gamma, Green 
Gamma, and Blue Gamma.

You can assign each control on the Colorociter to virtually any of the 
controls in Color Finesse. You can create your own pages of these 
assignments, modify the default pages, or any combination of the 
two. Your page definitions are saved and be reloaded each time Color 
Finesse is started.

To begin creating your own control assignments, open the Color 
Finesse Preferences and select the Control Surface pane. Click Define 
Actions to start the assignment process.

You’ll be presented with an overview image of the Colorociter control 
surface, showing all of the available controls. Clicking the image of a 
control on the overview will select that control for definition.

Control Page 5

Customizing Control 
Pages
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When you have completed defining the controls, click OK to save the 
new definitions. Your changes will take effect immediately, with no 
need to restart Color Finesse.

To change the control definitions for a given page, click the on-screen 
button for the page you wish to select. The Control Page Definition 
dialog will appear so that you can change the settings for the page.

The Enable Page checkbox defines whether or not the page is active. 
Pressing the Colorociter button for an inactive page will have no 
effect and you’ll hear the system alert sound.

The Trackball Color popup menus allow you to select the color of the 
trackball when the page is selected. Giving each page a different color 
combination makes it easy to tell which page is selected at a glance. 
Or you can select colors that go well with your room decor.

The Display text editing boxes allow you to define the text that will 
be displayed on the Colorociter’s alphanumeric displays when the 
page is selected.

When you have completed adjusting the settings, click OK.

To select what happens when you press one of the Colorociter’s 
buttons, click the on-screen button you wish to define. The Control 
Button Definition dialog will appear.

Creating Custom Pages

Defining Control Button 
Behavior



	 Using the Colorociter Colorist’s Workstation	 79

The dialog contains two columns of controls; the left column defines 
what will happen when the button is single-clicked and the right 
column defines what will happen when it is double-clicked. Normally 
you would want the single-click and double-click actions to be related 
for ease in remembering the function, but there is no requirement 
that you do so.

From the Action popup menu choose what should happen when the 
button is either single- or double-clicked. If you want the button to be 
ignored, select None.

If you want the button to toggle a control on and off, select Toggle 
Control State and choose the control to toggle from the Control 
popup.

If you want the button to set a control to a specific state, select Set 
Control State and choose the desired control from the Control popup. 
Enter the desired control state in the Control Value text edit field.

You can define the button so that it will toggle left, right, or settings 
pane each time it is clicked by selecting Toggle Left Pane, Toggle Right 
Pane, or Toggle Settings Pane in the Action popup.

Finally, you can define the button to save or restore the color 
correction settings to one of eight saved QuickGrade grades; the same 
saved grades which can be accessed via the keyboard function keys. 
Select Save Settings or Restore Settings as the Action, and enter a 
number from 1 to 8 in the Control Value field to specify which of the 
saved QuickGrades you wish to use.
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With any of the actions, you can choose whether or not the 
Colorociter status LEDs are updated after the action is completed. If 
you know that a given action won’t change the LED status, you can 
uncheck this box to slightly reduce overhead.

When you have completed adjusting the settings, click OK.

The Colorociter contains twelve control knobs and four trackball rings 
which behave as knobs. You can assign these knobs to adjust color 
correction controls, select interface panes, or move the preview split 
screen point.

To select what happens when you rotate one of the Colorociter’s 
knobs, click the on-screen knob you wish to define. The Control Knob 
Definition dialog will appear.

To have the knob adjust a control value, select Adjust Control in the 
Action popup, and select the control you want the knob to adjust in 
the Control popup. Because the knob may be more sensitive than 
you want—making it difficult to make fine adjustments with the 
knob—you can specify a scaling factor in the Scale Factor text edit 
box. This value is multiplied by the movement of the knob to reduce 
its sensitivity. You can select a value that gives the “feel” you desire. 
Value are typically in the 0.0625 (one-sixteenth) to 1.0 range. You can 
even specify a negative scale factor to reverse the effect of the knob so 
that a counter-clockwise motion will increase the value.

Defining Control Knob 
Behavior
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To use a knob to select the current interface pane, choose Select 
Left Pane, Select Right Pane, or Select Settings Pane from the Action 
popup.

To use a knob to adjust the split screen point, choose Wipe Left Pane 
Split or Wipe Right Pane Split from the Action popup. Moving the 
knob will then move the split left and right.

Some knobs—specifically the six knobs located in the upper right of 
the Colorociter—are buttons as well as knobs. In addition to being 
turned as knobs, they can can also be pushed down as buttons. When 
defining the behavior of these knobs, you’ll see button options as well 
as knob options in the dialog:

You define these “knob buttons” just as you would any other button.

When you have completed adjusting the settings, click OK.

The Colorociter contains four trackballs that allow you to adjust a 
control in two dimensions at the same time by moving the trackball 
both vertically and horizontally. This is ideal for the HSL Hue Offset 
controls, but can be used to control any pair of controls.

To select what happens when you move one of the Colorociter’s 
trackballs, click the on-screen trackball you wish to define. The 
Trackball Definition dialog will appear.

Defining Trackball 
Behavior
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Defining a trackball control is very similar to defining a knob control, 
except that you must define actions for movements in both the X- 
and Y-axis.

The trackballs are very sensitive controls, so the scale factor will 
normally be set to a fairly small number.

When you have completed adjusting the settings, click OK.
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 Using the Tangent Wave 
Control Surface

13

In addition to the Colorociter control surface, Color Finesse also 
supports the Tangent Wave, an optional hardware control surface 
which provides a tactile interface for improved color correction 
efficiency.

The Wave consists of three trackballs with rotation controls and reset 
buttons, nine encoders with integral pushbuttons, nine matching 
buttons, nine function buttons, page-up and page-down buttons, 
transport controls, and three alphanumeric displays.

Using a control surface avoids much of the mousing and keyboard 
use normally done during correction. Controls from different settings 
panes are available without using the mouse to switch panes, and 
more than one control can be adjusted at once. And because you get 
the tactile feedback of using a physical control, adjustments can be 
made more quickly and more accurately than when dragging a virtual 
slider control on-screen.

Physical installation and cabling of the Wave is covered in 
documentation which accompanies the Wave hardware. It connects 
to your computer via a USB 2.0 cable and makes use of the operating 

Installing the Wave



system’s built-in USB support, so no additional drivers are needed. 
Both Macintosh and Windows systems are supported by the Wave.

To select the Wave for use with Color Finesse, open the Color Finesse 
Preferences and select the Control Surface pane.

Verify that the Control Surface Type is set to Tangent Wave CP-300. 
Click the Reset Control Surface button to force a reset of the Wave. 
You should see the displays on the Wave initialize. Click OK in the 
Preferences dialog and the Wave will be active.

If the USB connection should be lost at some point and you need to 
re-initialize the control surface, entering Preferences and clicking the 
Reset Control Surface button will force a re-initialization.

Once you have selected the Wave as your control surface, Color 
Finesse will initialize it each time you enter the Color Finesse full UI.

The Wave controls are assigned to give you access to all of the 
commonly used color correction controls, while still giving access to 
specialized controls via standard mouse/keyboard interaction.

The alphanumeric displays are used to show current control 
assignments (which knob controls what), the current control value, 

Common Controls
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and the function of the control buttons for selecting active control 
groups.

The knobs at the top of the Wave are assigned to controls within 
the currently active control group. The buttons just below the 
alphanumeric displays are used to select the active control group.

Turning the knob adjusts the control value. Clicking on the knob will 
reset the value to its default.

To select the tonal range (master/highlight/midtone/shadow) within 
the current control group, use the up- and down-arrow buttons in the 
upper-right of the Wave. These buttons will cycle through the tonal 
ranges, which will be reflected in the labels in the alphanumeric 
displays.

The three trackballs are programmed to behave the same regardless of 
which control page is selected. The trackballs are assigned to the 
Shadow, Midtone, and Highlight HSL Hue Offset wheel controls, 
left-to-right. The rotational knobs just above the trackballs adjust the 
hue, while the trackballs themselves adjust both hue and strength. 
The two buttons to the upper-right of the trackballs reset the 
individual trackball settings.

To reset all color correction controls to their default values, press the 
F9 button twice in rapid succession, as if you were double-clicking the 
mouse button. This will reset all controls, not just those mapped to 
the Wave controls.

The buttons F1 through F8 are used to store and recall color 
correction settings as saved QuickGrades, just as can be done with the 
keyboard functions keys F1-F8.

To store the current settings for later recall, choose one of the eight 
QuickGrade buttons. Double-click the function button—in the 
manner you would double-click a mouse button—to store the color 
correction settings into that button. You can store color correction 
settings in each of the eight buttons.

To recall the setting stored in the button, press the button. The 
correction settings will be recalled and applied to the current clip.

The transport controls (in the lower-right portion of the Wave) can be 
used to move through the clip being color corrected. The functions of 

Selecting Control Tonal 
Ranges

Using the Trackballs

Resetting Controls

Saving and Restoring 
QuickGrades

Transport Controls
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the controls mimic those of standard VTR controls, letting you shuttle 
through the clip, play the clip, and step a frame at a time.
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 Keyboard Shortcuts A

Color Finesse offers keyboard shortcuts for many menu commands 
and to streamline moving through the user interface.

To move rapidly through the user interface, use the following one and 
two keystroke shortcuts. No modifier key (other than shift) is needed 
with these keystrokes.

Settings Window Shortcuts

Control Group Control Keystrokes
HSL Controls Master u a

Highlights u h

Midtones u m

Shadows u s

HSL Hue Offsets w

RGB Controls Master p a

Highlights p h

Midtones  m

Shadows p s

CMY Controls Master t a

Highlights t h

Midtones t m

Shadows t s

YCbCr Controls Master y a

Highlights y h

Midtones y m

Shadows y s

Curves c

User Interface 
Navigation Shortcuts

Settings Window 
Shortcuts
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Control Group Control Keystrokes
Levels Master v 

Highlights v h

Midtones v m

Shadows v s

Luma Range n

Secondary Controls A d a

B d b

C d c

D d d

E d e

F d f

Limiting l

Image Window Shortcuts

Pane Keystrokes
Result Pane R

Source Pane S

Reference Pane F

Split Source Pane I

Split Reference Pane T

Luma Ranges Pane L

Analysis Window Shortcuts

Pane Keystroke
Combo Pane C

Reference Pane E

Luma Waveform Monitor W

YC Waveform Monitor Q

RGB Parade Waveform Monitor P

YRGB Parade Waveform Monitor A

YCbCr Parade Waveform Monitor M

Overlay Waveform Monitor O

Image Window Shortcuts

Analysis Window 
Shortcuts
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Pane Keystroke
Vectorscope V

Histograms H

Level Curves N

Reference Gallery G

Menu Shortcuts

Menu Settings Macintosh Windows
Settings>Reset All shift+opt+cmd+R shift+ctrl+alt+R

Settings>Load Settings shift+opt+cmd+L shift+ctrl+alt+L

Settings>Save Settings shift+opt+cmd+S shift+ctrl+alt+S

Settings>Load User Preset shift+opt+cmd+P shift+ctrl+alt+P

Clip>Save Reference Image opt+cmd+R ctrl+alt+R

View>Single cmd+1 ctrl+1

View>Normal cmd+2 ctrl+2

Menu Shortcuts
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 Calibrating Video Monitors B

When previewing video output, it’s important that the video monitor 
be calibrated. Proper monitor calibration ensures that what you see 
today will match what you see tomorrow, and that the judgements 
and decisions you make based on what you see remain valid. 
Echo Fire—the realtime video previewing software which works in 
conjunction with After Effects and Photoshop—provides built-in tools 
to make the calibration process simpler, allowing you to calibrate 
frequently.

Not everyone sees colors and brightness the same. If monitor settings 
were left up to personal preference, everyone’s monitor would be set 
differently, making it impossible for people to agree on what video 
footage actually looked like and therefore what changes might be 
needed. By choosing a calibration standard we don’t necessarily 
make the picture look its best—that’s a subjective judgement in any 
case—but we attempt to make it look standard. If everyone viewing 
a project adheres to the same standard, then there will be much less 
disagreement over what, if any, changes are needed.

Even calibrated video monitors will differ in appearance due to a 
number of factors. Different monitors use different phosphors in the 
CRT. For NTSC, the standard phosphors are called SMPTE-C. For PAL, 
the standard phosphors are called EBU. If possible, choose a monitor 
with the appropriate standard phosphors.

Phosphors also wear out over time. In constant use, a video monitor 
can be significantly darker after only two years of use. For critical 
applications, it should be replaced. Some broadcast monitors have 
calibration probes that actually read the brightness and color values 
from the screen and automatically compensate for such phosphor 
wear. However, these are expensive and rarely found in most studios.

Monitor Differences
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The white point, or color temperature, is another difference between 
monitors. The broadcast standard is a white point of 6500K. Most 
television sets, in an effort to produce a brighter picture, use a white 
point of 9300K or higher, making the image brighter, but also much 
bluer. If your video monitor has selectable white point, choose 6500K. 
If your monitor does not, be aware of the color shifts caused by the 
different white point.

One of the first questions asked by people just starting with video is 
“Can’t I just use my spare television for video monitoring?”

The answer is: yes, but you don’t want to if you can afford a better 
alternative.

Monitoring on a television set is a big step up from trying to do it on 
a computer monitor. You get to see color differences (although with 
some other distortion) and interlace problems, which are the two 
main items that cause problems with computer-generated footage. But 
there are distinct advantages to using a real video monitor, despite 
the additional cost. And by real video monitor, we mean a monitor 
purpose-built for monitoring video signals, not for watching TV.

We’ve already discussed two of the differences: color temperature 
and standard phosphors. Color temperature is the more important of 
these and, fortunately, it’s an option found on most video monitors. 
Standard SMPTE-C or EBU phosphors are nice, but do add to the cost 
of the monitor.

The big advantage of a real video monitor is that it comes with 
a “Blue Only” button. Pressing this button routes the blue color 
signal to all three CRT guns, giving you a black-and-white picture 
representing just the blue portion of the image. This serves two 
purposes: the blue portion of the image is often the noisiest, so 
viewing just blue gives you a better idea of how noisy your material 
is; but more importantly, using just the blue channel is an important 
part of the calibration process. There are solutions to the lack of a Blue 
Only option, but having it does make calibration much simpler.

Professional video monitors also offer a variety of other options, 
and you can spend as much money as you want buying the biggest, 
most accurate monitor available. But having a monitor with standard 

Why You Want a Real 
Video Monitor

	 92	 Calibrating Video Monitors



	 Calibrating Video Monitors	 93

phosphors, correct white point, and a Blue Only button will make 
video monitoring more accurate and simpler for you.

To calibrate your video monitor you’ll need a source of accurate color 
bars, preferably SMPTE bars. You can use an external color bar 
generator or, if you have Echo Fire installed on your system, you can 
use Echo Fire’s built-in color bar generator.

With an external color bar generator, connect it to your monitor, 
ensuring that it is properly terminated.

To calibrate using Echo Fire, first start After Effects or Photoshop so 
that Echo Fire is active. Select SMPTE-Style color bars as the video 
source so that the bars appear on the video monitor.

To adjust the Chroma and Hue controls, first locate them on the 
monitor. They may be located behind a door, and the Hue control 
may be labeled Phase on some monitors. Some monitors also have a 
“control lock” function which disables the controls; if your monitor 
has such a lock, make sure the controls are unlocked. Next locate and 
engage the Blue Only control on your monitor. If your monitor 
doesn’t have a Blue Only control, you can make the adjustments by 
viewing the monitor through a Wratten 47B dark blue photographic 
filter, which can be purchased at any well-stocked camera store. Some 
monitors have individual controls for the red, green and blue guns 
instead of a Blue Only switch; in that case, disable the red and green 
guns so you are left with a blue image.

With the Blue Only switch engaged, or while viewing through the 
47B filter, you should see four brighter bars with three darker bars 
separating them. At the bottom of each of the four brighter bars is a 
small rectangular bar segment. Pay no attention to the other parts of 
the display.

You can now start adjusting the Hue and Chroma controls. The goal 
is to make the color and brightness of the brighter vertical bars match 
the rectangular bar segments below them using only the Hue and 
Chroma controls. Adjusting the Hue control mainly affects the two 
middle bars, while adjusting the Chroma control mainly affects the 
two outside bars. Continue adjusting both controls until all four bars 
match. Once all bars match, turn off the Blue Only switch.

Calibrating the 
Monitor

Adjusting Chroma and 
Hue



 
Locate the Brightness control on the monitor. Find the sixth (red) bar 
on the screen. Directly below this bar at the bottom of the screen you 
should see three narrow vertical bars which are different shades of 
gray. If the gray bars aren’t visible, increase the Brightness control 
until the three bars can be clearly seen.

Reduce the Brightness control until the middle gray bar just 
disappears from the screen. The three gray bars are known as the 
PLUGE (Picture Line-Up Generating Equipment) bars. The middle bar 
should be black, the right bar just barely visible as a very dark gray, 
and the leftmost bar should also be black and blend into the middle 
bar.

Adjusting Brightness and 
Contrast

Depending on the video output device you have selected, and the codec 
it’s using, the leftmost of these three bars may be missing or the same 
shade of gray as the middle bar. This is a limitation of the codec’s ability 
to produce a blacker-than-black video level. While not ideal, it won’t stop 
you from being able to calibrate your monitor; simply concentrate on the 
middle bar as you make the adjustments described.

Now locate the Contrast control. Adjust it until the white reference 
square at the lower left of the screen is bright enough to appear white, 
but not so bright that it is too bright to look at or causes the adjacent 
squares to glow. The Brightness and Contrast controls interact, so just 
keep adjusting them until you get the right combination of settings.

Once you have the Brightness and Contrast controls adjusted, the 
monitor calibration is complete.
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 Understanding the 
Waveform Monitor and 
Vectorscope

C

The waveform monitor and vectorscope displays which are part 
of Color Finesse are emulations of traditional video monitoring 
devices. While these emulations are software generated and show the 
contents of a digital video image, they provide the same important 
way to understand the content of your video as their physical, analog 
counterparts. If you are already familiar with using a waveform 
monitor (WFM) and vectorscope (VS), then the software version 
should need no explanation. If you are not familiar with their 
function, this appendix explains how to use them and interpret their 
displays.

A waveform monitor is used to display the level of the video signal 
over the width of one or more scan lines. Its primary use is to show 
the levels of the luma and chroma components of the video signal.

The width of the waveform monitor corresponds to the width of a 
video scan line; a point toward the left of the video monitor will be 
represented by a point toward the left of the waveform monitor.

The Waveform 
Monitor
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The height of the waveform monitor corresponds to the amplitude of 
the video signal; black is at the bottom of the display, and pure white 
is at the top. The display is calibrated in IRE units along the left side. 
Each vertical division in the display represents 10 IRE. The overall 
range will depend on the choices you have selected in the Levels 
preference settings.

Using the waveform monitor, you can see not only the level of 
a particular pixel, but can also easily determine the darkest and 
brightest levels present in the video signal, and also see how the 
brightness levels are distributed across the range of black to white.

In this section we show some samples of a video frame and its 
corresponding waveform monitor display. Of course, the type of video 
image greatly affects the interpretation of the waveform monitor 
display—an image shot in the snow in sunlight would not be 
expected to have a lot of dark portions—but the principals remain the 
same.

This frame shows a good range of luma values, from black (shown on the 
waveform monitor at the bottom of the display) to white (shown at the 
top), as well as a full range in between.

Interpreting the Display
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This frame shows that there is white clipping occurring, losing detail in 
the bright portions of the image and giving it a chalky appearance. Notice 
how the waveform monitor shows portions of the image compressed 
against the top of the display.

This frame is missing any bright values, giving it a dark, washed-out 
appearance. Notice in the waveform monitor how there are no values 
shown at the top of the display, indicating a lack of bright values.

In this frame, while we see that are both dark and light extremes, the bulk 
of the values are concentrated in the upper part of the waveform monitor 
display, indicating a light, washed-out display.

The vectorscope is a tool used to visualize the color content of a video 
signal. It displays the two components of color—hue and saturation— 
in a way that allows a color to be precisely measured—far more 
precisely than your eye can evaluate a color on a video monitor. 

The Vectorscope
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Moreover, a video monitor must be properly calibrated or it will 
distort the colors itself.

A given point in the video waveform—a specific pixel once the video 
has been digitized—will have a specific color, represented by that 
color’s hue and saturation. To represent that color on the vectorscope, 
there is a specific point on the vectorscope display that corresponds to 
that hue and saturation.

Hue is represented by counter-clockwise rotation around the center 
of the display (0° to 360°) representing the 0° to 360° degree phase 
change used to represent hue in the composite color signal. By 
convention, we refer to the right side of the display (the “east” side or 
the positive X axis in Cartesian space) as 0 degrees.

Saturation is represented by the distance from the center of the 
display, just as saturation is encoded into the composite color signal 
as the amplitude of the color subcarrier. Blacks, grays, and whites will 
appear at the center of the vectorscope because they have no color 
saturation; a vivid color will appear towards the outside of the display.

If you apply a filter to your video, it is easy to see how changes in the 
hue and saturation of the video are shown in the vectorscope display. 
Adjust the hue and you will see the signal rotate around the center 
point of the vectorscope. Adjust the saturation and you will see the 
display move towards the center as you decrease saturation and out 
from the center as you increase it.
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The vectorscope contains six calibrated boxes that correspond to the 
six colors contained in the standard color bar test signal. If the test 
signal is undistorted, each color bar should be represented by a point 
of light landing within each box.

Color Finesse’s vectorscope can be calibrated for 75% or 100% color 
bars by changing the vectorscope settings in the Preferences.

Colors with very low saturation all appear near the center of the 
vectorscope. This can make it very hard to see small color casts in 
highlights, midtones, or shadows as the display is often very crowded 
near the center. The solution to this is to zoom into the display, 
making it much easier to see low saturation pixels.

On a hardware vectorscope there is ususally a zoom knob or series 
of buttons; in Color Finesse you can zoom into the display using the 
scrollwheel on your mouse or by right-clicking on the display and 
choosing a zoom factor from the popup menu.

The YCbCr parade display is a hybrid display which looks very similar 
to a standard waveform monitor, but shows both luma and chroma 
levels. Hardware parade displays are often used to monitor the levels 
in component video signals. Color Finesses’s display mimics such a 
hardware display, but can be used with any type of video output, 
component, composite, or FireWire.

A parade display is similar to the traditional waveform monitor, but 
it is broken into three sections. The leftmost portion displays the 

Level Calibration

Zooming

The YCbCr Parade 
Display
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luma information from the video, just as with the waveform monitor 
described above. Use it to evaluate the image brightness.

The middle portion displays the B-Y chroma information, and the 
rightmost portion displays the R-Y chroma information. The chroma 
information ranges from +100% at the top of the display to -100% at 
the bottom of the display.

The parade display provides a quick way to judge both luma levels 
and chroma saturation in a single display. As you adjust an image you 
can easily watch the parade display to see your adjustment’s effect on 
both luma and chroma levels on a single display, rather than having 
to watch both a waveform monitor and vectorscope. Using those two 
instruments is functionally identical to using the parade display, so 
it comes down to using whichever displays you are most comfortable 
with.

The YRGB parade display is similar to the YCbCr parade display, but 
shows the luma level along with the individual red, green, and blue 
channel levels. Many people find it easier to interpret the primary 
color channels than the encoded chroma channels of YCbCr. Also, for 
imagery that will never be encoded as component video, but will 
instead stay in the RGB space, the YRGB parade display shows more 
information.

A parade display is similar to the traditional waveform monitor, but 
it is broken into four sections. The leftmost portion displays the 

The YRGB Parade 
Display
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luma information from the video, just as with the waveform monitor 
described above. Use it to evaluate the image brightness.

The next three sections show the levels of the red, green, and blue 
primary color channels.

The parade display provides a quick way to judge both luma levels 
and color levels in a single display.

In addition to the YRGB parade display, Color Finesse also offers 
RGB and GBR parade displays which works the same way, but do not 
show the luma level. Which parade display you prefer—and the color 
channel ordering of RGB or GBR—is a matter of personal preference.
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 For More Information D

There is a lot more to the art and craft of color correction than can be 
covered in a user’s guide like this. To learn more about the techniques 
of color correction and the tools used to do it, there are a number of 
good books available.

The books listed below are available from booksellers both on-line 
and off, and may also be ordered at the Synthetic Aperture Book 
Store, www.synthetic-ap.com/support/reading.html.

The following books specifically cover color correction for video and 
film:

Color Correction for Digital Video: Using Desktop Tools to Perfect Your Image, 
Steve Hullfish and Jaime Fowler, ISBN: 0240810783

The Art and Technique of Digital Color Correction, Steve Hullfish, ISBN: 
0240809904

Video Color Correction for Non-Linear Editors: A Step-by-Step Guide, Stuart 
Blake Jones, ISBN: 0240805151

Digital Intermediates for Film and Video, Jack James, ISBN: 0240807022

Film Technology in Post Production, Dominic Case, ISBN: 0240516508

The following books focus more on color correction for print 
applications. However, many of the same concepts apply:

The Complete Guide to Digital Color Correction, Michael Walker and Neil 
Barstow, ISBN: 1579905439

Professional Photoshop: The Classic Guide to Color Correction, Dan 
Margulis, ISBN: 0764536958

Books on Video and 
Film Color Correction

Books on General 
Color Correction
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The following book covers the use of video test instruments, such as 
the waveform monitor and vectorscope:

An Introduction to Video and Audio Measurement, Peter Hodges, ISBN: 
0240806212

We maintain a list of available on-line video training and tutorial 
materials on the Color Finesse website at http://www.synthetic-ap.com/
support/kb/420301.html.

Books on Video 
Measurement

On-line Video Training 
and Tutorials
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A

Acrobat  7
Activating panes  17
adding control point to curve  54
adding reference images  30
adjusting curves  54. See also curves
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histogram  34
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Reference Gallery  16, 29. See also Reference 
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vectorscope  33
waveform monitor  32
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channel correction  49
chroma limiting  71

limit method  71
max limit  71
min limit  71
previewing  72
video system selection  72

clip playback  20
realtime  20
scrubbing  20
VTR-style controls  20

CMY correction  50
color bars  99
color channel correction  49
color correction  1

primary  10
resources  103
secondary  10
theory of  9

Color Decision List (CDL)  22
Color Finesse

applying to After Effects clip  11
applying to Final Cut Pro clip  11
applying to Premiere Pro clip  12
basic operation  13
correction processing order  27
CPU requirements  3
full interface  11, 15
installing  3

location  5, 6
Macintosh  4
Windows  5

keyboard shortcuts  87
memory requirements  3
navigating  17
new features  1
simplified interface  13
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starting  11
Color Info Window  17, 23

tools  23
color matching  25, 45, 52, 56
Colorociter  40, 73
color sampler  23, 24
color temperature  61
color wheels  46

resetting  47
combo display pane  35

preferences  40
composite video levels  71
contrast  42
contrast center  42
control surface  40, 73, 83
CPU requirements  3
curves

adding a control point  54
black, white, gray balancing  55
deleting a control point  54
HSL  53
loading  56
moving a control point  54
resetting  56
RGB  53
saving  56

Curves correction pane  53
customizing

combo display  40
control surface connection  40
disk cache  40
external previewing  40
Reference Gallery  31
vectorscope display  39
video system settings  38
waveform monitor display  39

D

defining tonal ranges  44
deleting control point from curve  54
demo mode  6
disabling multiple processors  38
disk cache  40

E

external previews  39

F

FAQ  8
Final Cut Pro  3

applying Color Finesse  11
full interface  15

navigating  17

G

gain correction  50
gamma correction  43, 49, 51
gray balancing  55

H

highlight recovery  61
highlights  43
Histogram pane  34
HSL Controls pane  41
HSL (Hue-Saturation-Lightness)  41
hue correction  41
Hue Offsets pane  46

I

image preview LUTs. See LUTs
image processing order  27
image updating

disabling  22
enabling  22
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Image Window  16
default  17
Luma Ranges pane  18
Reference pane  18
Result pane  18
Source pane  18
split screens  18

installation  3
Macintosh  4
Windows  5

K

Keep UI Running option  38
keyboard shortcuts  87

L

Level Curves pane  34
level limiting  69

default setting  38
luma limiting  69
luma soft clipping  61, 70

levels correction  59
adjusting input black and white points  60
adjusting input gray points  60
adjusting output black and white points  61
auto color  61
auto exposure  62
channel controls  60
highlight recovery  61
white balance  61

Levels pane  60
levels corrections  59

loading curves  56
lookup tables  25. See also LUTs
luma hard clipping  70
luma limiting  69
Luma Ranges pane  16

luma ranges preview  44
luma soft clipping  61, 70
LUTs  25

1-D  26
3-D  26
creating  26
loading  26
supported formats  26

M

manual  3
midtones  43
moving control point on curve  54
multiple processors  38

N

navigating  17
new features  1

P

panning  18
pedestal correction  43, 49
pixel aspect ratio  2
preferences  37

combo display  40
control surface  40
disk cache  40
general  37
preview  39
vectorscope  39
video system settings  38
waveform monitor  39

Premiere Pro, applying Color Finesse  12
preview  39

external  39
out of limit chroma  72
secondary color selection  65
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secondary preview monitor  40
Preview pane  18

clip playback  20
enlarging  20
panning  18
zooming  18

primary color correction  10
processing order  27

Q

QuickGrade  22, 76, 85

R

Rapid Preview  20
realtime playback  21
Reference Gallery  29

adding images  30
comment field  31
customizing  31
removing images  30
saving setting presets  31
selecting images  30
sorting images  31
using folders  30

Reference pane  16
registering Color Finesse  5, 6
removing reference images  30
resetting controls  21
resetting curves  56
Result pane  16
RGB correction  49
RGB gain correction  42
RGB waveform monitor  32

S

sampling image colors  24

saturation  42
saving curves  56
scroll wheel, using  21
scrubbing clip  20
secondary color correction  10, 63

basic theory  63
chroma tolerance control  65
gain control  67
gamma control  67
hue control  66
hue offset control  67
inverting preview  66
luma tolerance  66
modifying selection  66
pedestal control  67
previewing  65
saturation control  66
selecting samples  64
softness control  66

secondary preview monitor  40
selecting reference images  30
serial number  5, 6
settings

CDL format files  22
menu  22
saving and restoring  22

Settings Window  17
activating panes  17
default  17
entering numeric values  23
options  23

shadows  43
simplified interface  13
Source pane  16
Split Ref pane  18
split screen
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locating split  19
markers  19
moving split  19

Split Source pane  18
split wipe  18
system requirements

Macintosh  3
Windows  3

T

Tangent Wave  83
Technical Support  7
tonal correction  43, 50
tonal ranges, defining  44
Tool Tips  37

U

undo/redo  21
levels  21, 37

user interface. See full interface

V

vectorscope
calibration  99
configuring display  33
customizing display  39
understanding  97
zooming  99

vibrance  42

video monitors, calibrating  91. See 
also calibrating video monitors
video system settings  38

W

Wave. See Tangent Wave
waveform monitor

configuring display  32, 39
RGB  32
understanding  95
YC  32
YCbCr  33

white balance  61
white balancing  55

Y

YCbCr correction  51
YC waveform monitor  32

Z

zooming  18
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